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In This Guide…
This handbook describes what you have to do to install your new Agilent 
8453 UV- visible spectroscopy system. Most of the handbook deals with 
installing a complete system, that is, the spectrophotometer, computer and 
printer. However, in the second half of this handbook you will find 
additional information about installing accessories, accessory boards, GPIB 
connections and configuration, and software installation.

1 Fast Installation

Use this chapter as an overview of the different actions you want to 
perform to install an Agilent 8453 UV- visible spectroscopy system. If you 
are an experienced user of analytical equipment from Agilent 
Technologies, this may be all you need. If you need more information, this 
chapter guides you to other relevant areas in this or another handbooks.

2 Installation and Start Up

Use this chapter if you need more detailed information to begin with.

3 Good Measurement Practices

Use this chapter if you require information about general operating 
conditions to perform accurate and reliable measurements, for example, 
handling samples, solvents and cells.

4 Installing Accessories

This chapter describes how to install the simple mechanical and optical 
accessories that are available to expand the capabilities of your Agilent 
8453 spectrophotometer.

5 Installing the UV-visible Software

This chapter describes what your computer needs to have and what you 
need to do to install the software.

6 GPIB Communication, Connections and Configuration

This chapter describes how to set the select code, how to install an GPIB 
card in your computer and how to change the GPIB address of your 
spectrophotometer.
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7 LAN Communication, Installation, Connection and Configuration

This chapter describes how to set up LAN communication between your 
Agilent ChemStation and Agilent 8453 spectrophotometer.

A Safety Information

This chapter contains relevant safety information.
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1
Fast Installation

Installing Preconfigured Agilent 8453 Systems 12

Installing Agilent 8453 Systems 13

Installing Software Only 15

Installation is straightforward, but if you have difficulties or need more 
information references to detailed installation information are given.

Use this chapter if you are:

• installing a preconfigured Agilent 8453 UV- visible spectroscopy system 
from Agilent (including spectrophotometer, computer and software),

• installing an Agilent 8453 UV- visible spectroscopy system not purchased 
as a preconfigured system, or

• installing software only.
11Agilent Technologies



1 Fast Installation
Installing Preconfigured Agilent 8453 Systems
Installing Preconfigured Agilent 8453 Systems

If you have purchased one of these systems the software is pre- installed 
and preconfigured. You need only to install and switch on the hardware.

✔ Ensure you have space and appropriate power supplies.

For more information, see “Site Requirements for Your Agilent 8453 
Spectrophotometer” on page 19.

✔ Unpack the system—check for damage and contents against packing list.

For more information, see “Unpacking Your Agilent 8453 
Spectrophotometer” on page 22.

✔ Install your Agilent 8453 spectrophotometer.

• Connect line power to the rear.

• Connect the waste tubing underneath the sample pan.

For more information, see “Installing your Agilent 8453 
Spectrophotometer” on page 23.

✔ Install your computer and printer.

• Connect keyboard and mouse.

• Connect monitor to line power and the computer.

• Connect printer to line power and the computer.

• Connect to the spectrophotometer with the GPIB or LAN cable.

For more information, see “Installing Your Computer” on page 29 and 
Chapter 7, “LAN Communication, Installation, Connection and 
Configuration”.

✔ Switch on the Agilent 8453 (make sure sample area is clear), wait 2 
minutes for the lamps to ignite. When you are ready to operate your 
spectrophotometer switch on the computer and printer.

For more information, see “Starting the Agilent 8453 
Spectrophotometer” on page 31.
12 Agilent 8453 UV-visible Spectroscopy System Installation Guide



Fast Installation 1
Installing Agilent 8453 Systems
Installing Agilent 8453 Systems

The software has to be installed and configured. In addition the required 
interface for the instrument communication may have to be installed (e.g. 
GPIB PCI interface card) and configured. 

✔ Ensure you have space and appropriate power supplies.

For more information, see “Site Requirements for Your Agilent 8453 
Spectrophotometer” on page 19. 

✔ Unpack the system -  check for damage and contents against packing 
list.

For more information, see “Unpacking Your Agilent 8453 
Spectrophotometer” on page 22.

✔ Install your Agilent 8453 spectrophotometer.

• Connect line power to the rear.

• Connect the waste tubing underneath the sample pan.

For more information, see “Installing your Agilent 8453 
Spectrophotometer” on page 23.

✔ In case your computer and printer are not supplied by Agilent ensure 
that the requirements for proper operation of the software are met.

For more information, see “Minimum PC Requirements for the 
Agilent ChemStation” on page 66.

✔ Install the GPIB interface board in your computer.

For more information, see “Installing an GPIB Interface” on page 81.

✔ Install your computer and printer.

• Connect keyboard and mouse.

• Connect monitor to line power and the computer.

• Connect printer to line power and the computer.

• Connect to the spectrophotometer with the GPIB cable.

For more information, see “Installing Your Computer” on page 29.
Agilent 8453 UV-visible Spectroscopy System Installation Guide 13



1 Fast Installation
Installing Agilent 8453 Systems
✔ Switch on the Agilent 8453 (make sure sample area is clear), wait 2 
minutes for the lamps to ignite. When you are ready to operate your 
spectrophotometer switch on the computer and printer.

For more information, see “Starting the Agilent 8453 
Spectrophotometer” on page 31.

✔ From the Windows menu install the Agilent ChemStation software.

For more information, see “Installing the Agilent ChemStation Using 
CD- ROM” on page 69.

✔ From the Windows menu start the Agilent ChemStation software.

For more information, see “Starting the Agilent ChemStation 
Software” on page 34.

✔ Check if your software and spectrophotometer operate properly, taking 
a blank measurement or performing the automatic self- test in the 
diagnostic section of your software.

For more information, see “Operational Checkout” on page 34.

✔ If you need information about solvents, sample preparation, blank 
measurements, cuvette handling or how to insert a cuvette, see 
Chapter 3, “Good Measurement Practices”.

✔ Install any accessories.

For simple accessories see Chapter 4, “Installing Accessories”, for 
complex accessories see instructions supplied with the accessory or the 
Installation and Maintenance section of the Agilent ChemStation online 
help.
14 Agilent 8453 UV-visible Spectroscopy System Installation Guide
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Installing Software Only

✔ Unpack the software—check for damage and contents against packing 
list.

✔ Ensure that your computer and printer meet the requirements for 
proper operation of the software.

For more information, see “Minimum PC Requirements for the 
Agilent ChemStation” on page 66.

✔ Switch on the Agilent 8453 (make sure sample area is clear), wait 2 
minutes for the lamps to ignite. When you are ready to operate your 
spectrophotometer switch on the computer and printer.

✔ From the Windows menu install the Agilent ChemStation software.

For more information, see “Installing the Agilent ChemStation Using 
CD- ROM” on page 69.

✔ From the Windows menu start the Agilent ChemStation software.

For more information, see “Starting the Agilent ChemStation 
Software” on page 34.

✔ Check if your software and spectrophotometer operate properly, taking 
a blank measurement or performing the automatic self- test in the 
diagnostic section of your software.

For more information, see “Operational Checkout” on page 34.
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2
Installation and Start Up

Site Requirements for Your Agilent 8453 Spectrophotometer 19

Unpacking Your Agilent 8453 Spectrophotometer 22

Installing your Agilent 8453 Spectrophotometer 23

Installing Your Computer 29

Starting the Agilent 8453 Spectrophotometer 31

Starting the Agilent ChemStation Software 34

Operational Checkout 34

The following topics are covered in this section:

• “Site Requirements for Your Agilent 8453 Spectrophotometer” on 
page 19 contains information about electrical requirements, i.e. power 
lines, power cords, etc. It also gives recommendation for minimum 
available bench space and environmental conditions in the laboratory. 

• “Unpacking Your Agilent 8453 Spectrophotometer” on page 22 contains 
information about what you do when the packing material is damaged 
or the shipment is incomplete. It also gives a list of items which comes 
with the instrument and computer.

• “Installing your Agilent 8453 Spectrophotometer” on page 23 gives an 
overview of the instrument and explains pushbuttons, indicators and 
line power switch. It gives instructions where and how to do line power 
connection, communication connections and where to install the waste 
drain tubing. 

• “Installing Your Computer” on page 29 describes how you install the 
computer and peripherals, e.g. monitor, mouse, keyboard and printer. 
Because the UV- Visible operating software comes already installed when 
the system has been ordered as a bundle, this topic is covered in 
Chapter 6, “GPIB Communication, Connections and Configuration”.
17Agilent Technologies



2 Installation and Start Up
• “Starting the Agilent 8453 Spectrophotometer” on page 31 describes the 
turn- on procedure of the spectrophotometer and the warm up time 
required to fulfill all specifications.

• “Starting the Agilent ChemStation Software” on page 34 describes how 
you start Windows from the MS- DOS operating system and how you 
start your Agilent ChemStation software.

• “Operational Checkout” on page 34—use this section to check if your 
spectrophotometer in combination with the computer and the UV- visible 
operating software is in proper operating condition. Optionally there is 
an automated self- test which can be used for a quick check out of the 
spectrophotometer. This self- test can only be executed after 1 hour 
warm- up time of the instrument.
18 Agilent 8453 UV-visible Spectroscopy System Installation Guide
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Site Requirements for Your Agilent 8453 Spectrophotometer

Power considerations

Your spectrophotometer can operate on a line voltage of 100–120 or 
220–240 V AC ±10% with a line frequency of 50 or 60 Hz ±5%. Maximum 
power consumption is 220 VA.

The instrument power supply has wide ranging capability. It accepts any 
line voltage supplied in the above mentioned range. Consequently there is 
no voltage selector in the rear of the spectrophotometer. There are no 
externally accessible fuses, because automatic electronic fuses are 
implemented in the power supply.

The computer and InkJet or LaserJet printers accept a nominal line 
voltage of 110 or 220 V AC with a line frequency of 50 or 60 Hz. For 
more information, see the documentation that comes with your computer 
and/or printer.

WARNING To disconnect the instrument from line, pull out the power cord. The power supply 
still uses some power, even if the power switch on the front panel is turned off.

WARNING If you connect your instrument to a line voltage that is higher than specified, shock 
hazard or damage to your instrument can occur.
Agilent 8453 UV-visible Spectroscopy System Installation Guide 19



2 Installation and Start Up
Site Requirements for Your Agilent 8453 Spectrophotometer
Power cords

Different power cords are offered as options with the spectrophotometer. 
The female end of each of the power cords is identical. It plugs into the 
power- input socket at the rear of the spectrophotometer. The male end of 
each of the power cords is different and designed to match the wall socket 
of a particular country or region.

Space

The spectrophotometer is 34.4 cm (13.5 inches) wide, 56.0 cm 
(22.0 inches) deep and 18.5 cm (7.3 inches) high (see Figure 1 on 
page 24). It weighs only 14 kg (30.86 lbs) so it will fit on almost any desk 
or laboratory bench. It needs an additional 2.5 cm (1.0 inches) of space 
on either side to allow for the circulation of air for cooling and 
approximately 8 cm (3.1 inches) in the rear for electrical connections.

The computer including the keyboard is approximately 50 cm (19.7 inches) 
wide and 60 cm (23.6 inches) deep.

Additional space is required for accessories like pumps and autosamplers.

WARNING Always operate your instrument from a power outlet which has a ground 
connection. Always use the power cord designed for your region.
20 Agilent 8453 UV-visible Spectroscopy System Installation Guide
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Environment

Your spectrophotometer will operate within specifications at ambient 
temperatures of 0 to 55° C (32 to 131° F).

The spectrophotometer can be shipped or stored where the ambient 
temperature is between - 40 and 70° C (- 4 and 158° F).

You can operate your spectrophotometer in environments with relative 
humidity up to 95 % (non- condensing) provided the temperature is 
between 25 and 40° C (77 to 104° F).

Avoid air circulation of varying temperatures (like from refrigerators or air 
conditioners) and exposure to direct sun light to ensure the instrument 
operates within performance specifications.

Your spectrophotometer can be stored at altitudes up to 4,600 m 
(14,950 ft.) and operated at altitudes up to 2,000 m (6,500 ft.).

WARNING If you use the instrument at environmental temperatures higher than 50°C (122°F), 
the rear of the instrument may get hot.

WARNING Do not store, ship or use your instrument under conditions where temperature 
fluctuations could cause condensation within the instrument. Condensation will 
damage the electronics. If your instrument was shipped in cold weather, leave it in 
its box and allow it to warm up slowly to room temperature to avoid condensation.
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Unpacking Your Agilent 8453 Spectrophotometer

Upon receipt of your spectrophotometer, computer and printer, inspect the 
shipping containers for any signs of damage. If the containers or 
cushioning material are damaged, save them until the contents have been 
checked for completeness and the spectrophotometer, computer or printer 
have been mechanically and electrically checked. If the shipping container 
or cushioning material is damaged, notify the carrier as well as Agilent 
Technologies. Save the shipping material for the carrier’s inspection.

Check the contents of the shipping container against the list below. If any 
items are missing or obviously damaged, call Agilent Technologies.

✔ Unpack the spectrophotometer. You should have the following 
components:

• Power cord to connect the spectrophotometer to line power.

• LAN Interface, if you connect the spectrophotometer through LAN

• Waste tubing to connect the sample pan of your spectrophotometer to 
a waste container.

• Checkout sample (caffeine solution).

✔ Unpack the computer and its accessories. You should have the following 
components:

• Computer and power cable

• Keyboard

• Mouse

• Display unit, connecting cable and power cable

• USB to GPIB Interface, if you connect the spectrophotometer through 
GPIB

• Printer, connecting cable and power cable

• Printer accessories, for example, ink cartridge in case of a DeskJet 
printer
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Installing your Agilent 8453 Spectrophotometer

Your spectrophotometer is very easy to install. This section provides an 
overview of the instrument and a checklist of the main installation 
procedure. If you have accessories for the spectrophotometer which are 
not covered in this section, see Chapter 4, “Installing Accessories” or refer 
to the documentation that was delivered with your accessories for detailed 
information.

Instrument overview

The front view of the spectrophotometer is shown in Figure 1. Notice that 
the sample compartment is open. Unlike conventional instruments the 
Agilent 8453 does not suffer from ambient stray light. The open sample 
area makes it easier to access it generally and to connect tubing to a flow 
cell or thermostattable cell holder. The spectrophotometer is shipped with 
the standard single- cell cell holder already in place. Standard and 
accessory cell holders can be removed and replaced in seconds with few 
or no tools.
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2 Installation and Start Up
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The line power switch is located at the lower left part of the instrument. 
Pressing it in turns on the instrument. It stays pressed in and shows a 
green light when the instrument is turned on. When the line power switch 
stands out and the green light is off, the instrument is turned off.

On the front panel of the spectrophotometer is an indicator which will 
display different colors depending of the actual condition of the 
instrument.

• Green: the instrument is ready to measure.

• Green, blinking: the instrument is measuring.

• Yellow: the instrument is in busy state, for example, turning one of the 
lamps on or if both lamps are switched off.

• Red: Error condition, that is, the spectrophotometer does not pass one 
of the self tests which are run when the spectrophotometer is turned 
on or an error occurred during operation. In this case the UV- visible 
operating software gives a detailed error message and possible 
explanations are in the online help system. Additionally the Reference 
Manual gives information about troubleshooting.

Figure 1 Front View of the Spectrophotometer

Indicator

Pushbuttons
Line power switch 
with green light
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• Red, blinking: Error condition of the spectrophotometer processor 
system. Because in this case there is no communication with the 
computer there will be no error message. The online help system and 
the Reference Manual gives more information about troubleshooting.

The four pushbuttons on the front panel cause the following actions to be 
performed and the resulting data being sent to the computer.

• blank: the instrument takes a blank measurement, that is, a reference 
measurement of solvent without the analyte. This is used in all 
subsequent sample measurements until a new blank measurement is 
taken. A baseline spectrum is displayed on the computer.

• sample: the instrument takes a sample measurement or starts a series 
of measurements. This depends on the parameters set in your software.

• standard: the instrument takes a measurement of a standard. Additional 
information, such as concentration and so on, have to be entered in the 
operating software.

• stop: the instrument and/or software aborts any ongoing activity and 
returns to a to measure state.

All connections are made at the rear of the spectrophotometer, see 
Figure 2.

Figure 2 Rear View of the Spectrophotometer

Line connector

GPIB connector 
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Multicell transport 
connector

GP-IO connector
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Remote connector

Two CAN 
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LAN interface
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• The multi- cell connector allows you to connect the cable which comes 
from the multicell transport.

• The GPIO (general purpose input/output) connector allow you to 
connect your sipper and autosampler or other accessories.

• The remote connector may be used in combination with other analytical 
instruments from Agilent Technologies if you want to use features such 
as common shut down, prepare etc.

• The RS 232 connector may be used to control the spectrophotometer 
from a computer through RS 232 connection, using appropriate software 
(for future use). This connector needs to be activated by the 
configuration switch module next to the GPIB connector. The software 
needs the appropriate drivers to support this communication. See your 
software documentation for further information.

• The CAN bus is a serial bus with high speed data transfer. The two 
connectors for the CAN bus are also for future use.

• The GPIB connector is used to connect the spectrophotometer with a 
computer. The 8- bit configuration switch module next to the GPIB 
connector determines the GPIB address of your spectrophotometer. The 
switches are preset to a default address recognized by the operating 
software from Agilent Technologies.

• The MIO slot for the Lan interface.

• The accessory board slot is reserved for future use.

• The power input socket accepts a line voltage of 100–120 or 220–240 
V AC ±10% with a line frequency of 50 or 60 Hz ±5%. Maximum power 
consumption is 220 VA. There is no voltage selector on your 
spectrophotometer because the power supply has wide ranging 
capability. There are no externally accessible fuses, because automatic 
electronic fuses are implemented in the power supply. The security 
lever at the power input socket prevents that the spectrophotometer 
cover is taken off when line power is still connected.

On the right side of the instrument there is a door for exchanging the 
lamps. Behind this plastic door there is another sheet metal door. Two 
independent safety light switches are implemented. They automatically 
turn off the lamps when the sheet metal door is opened.
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Setting up the Spectrophotometer

Connecting Your Spectrophotometer via GPIB to the Computer

1 Identify the spectrophotometer’s configuration switch module, see 
Figure 3. For GPIB operation the default address is 25, that is, all 
switches are in the down position except for the switches 4, 5 and 8 
which are in up the position, resulting in a pattern 00011001 (where 0 
means down and 1 means up). No two instruments or accessories may 
share the same GPIB address. For alternate switch settings, see 
Chapter 6, “GPIB Communication, Connections and Configuration”.

2 Connect the GPIB cable to the GPIB connector at the rear of the 
spectrophotometer.

Connecting your Spectrophotometer via LAN to the Computer see 
Chapter 7, “LAN Communication, Installation, Connection and 
Configuration”

Connecting Power to Your Spectrophotometer

See Figure 2 on page 25.

1 Your line voltage must be between 100–120 or 220–240 V AC ±10% with 
a line frequency of 50 or 60 Hz ±5%. There is no voltage selector on 
your spectrophotometer because the power supply has automatic wide 
ranging capability.

2 Make sure the power switch of the spectrophotometer is in the off 
position, that is, the pushbutton stands out and the LED inside the 

Figure 3 Configuration Switch Module

1 2 3 4 5 6 7 8
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switch is off, see Figure 1.

3 Plug the female end of the power cord into the power input socket at 
the rear of the spectrophotometer. Plug the male end of the power cord 
into your electrical outlet.

Installing the Waste Tubing

There is a waste outlet for the sample area. It is used to drain any liquids 
which may come from the sample area in case of a leak or a spill to a 
waste container. To connect your waste tubing to the spectrophotometer:

1 Lift the front part of the spectrophotometer up so that you can locate 
the waste outlet underneath the sample pan.

2 Connect the waste tubing which comes with your spectrophotometer to 
the waste outlet underneath the sample pan.

3 Put the other end of the waste tubing into the waste container.

4 Make sure that the waste tubing has a constant down slope from the 
spectrophotometer to the waste container.

Figure 4 Connecting the Waste Tubing
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Installing Your Computer

Detailed instructions for installing your computer are specific to the type 
and configuration of the computer and are provided with it. This section 
gives a checklist of the main installation procedures; refer to the 
documentation that was delivered with your computer for detailed 
information.

Setting up the computer

✔ If you have any additional accessories, install them before you set up 
your computer:

• Additional memory, refer to your computer documentation.

• Additional mass storage devices (hard disk drive, tape drive, 
CD- ROM), refer to your computer documentation.

• Accessory boards excluding USB to GPIB interface, refer to your 
computer documentation.

• USB to GPIB interface, see “Installing an GPIB Interface” on page 81.

✔ Connect the keyboard and mouse to the sockets at the back of the 
computer.

✔ Connect the display unit to the video socket at the back of the 
computer. 

✔ Connect the printer cable to the socket on the printer and to the 
correct printer interface socket on the back of the computer. 

✔ Connect the GPIB connector of the USB to GPIB interface to the 
spectrophotometer’s GPIB connector and the USB connector to the 
computer or connect your LAN cable from the spectrophotometer to the 
LAN connector on the computer. 

If you have more GPIB instruments connected to your computer, see 
Chapter 6, “Installing an GPIB Interface” for correct GPIB cabling, 
because you must observe some basic rules. For correct setup, see 
Chapter 7, “LAN Communication, Installation, Connection and 
Configuration”.
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✔ Connect the power sockets to the computer, display and printer, and 
switch them on. Follow the instructions for setting up the computer in 
your computer documentation.
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Starting the Agilent 8453 Spectrophotometer

Before you turn on your spectrophotometer, make sure the light path 
through the sample compartment is clear. All filters should be removed 
from the light path. Anything blocking or absorbing part of the light beam 
could cause an error indication when you turn on the spectrophotometer.

The power switch is located at the left front of the spectrophotometer. 
When starting UV-Visible application software wait until the completion of 
the self- test procedures for the spectrophotometer. Otherwise the 
application software may not recognize the spectrophotometer.

Turning On

1 turn on your spectrophotometer with the pushbutton at the lower left 
part of the instrument. The pushbutton will stay pressed in and light 
green if power is present.

Figure 5 Turning on the Spectrophotometer

Line power switch 
with green light

Indicator
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2 The fan will start turning.

3 The indicator at the upper right corner of the front panel will light in 
three different colors. The yellow color which means busy will stay on 
during the start up and self test routines, until at least one of the 
lamps are ignited and the spectrophotometer is ready to operate.

4 The turn on procedure including electronic self tests lasts about 
20 seconds before the lamps start turning on. Under cold ambient 
conditions the lamp may not ignite and the instrument will repeat the 
ignition cycle automatically. The entire turn- on and self- test process 
will take about 1–2 minutes. Optical self tests are performed which last 
a few seconds.

5 When the green indicator at the upper right corner of the front panel 
comes on, the instrument is ready to measure and you can turn on 
your computer and printer.

In case the software is set to leave both lamps off at turn on of the 
spectrophotometer, the front panel indicator remains yellow.

If the indicator shows a red color, there is an error condition. Try 
turning on the spectrophotometer again.

• red: error condition, that is, the spectrophotometer does not pass one 
of the self- tests. In this case turn on your computer and start the 
UV- visible operating software. The software will give a detailed error 
message and possible explanations are in the online help system. 
Additionally the Reference Manual gives information about 
troubleshooting.

• red, blinking: error condition of the spectrophotometer processor 
system. Because in this case there is no communication with the 
computer there will be no error message. The online help system and 
the Reference Manual gives more information about troubleshooting.
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Instrument Warm-up

Technically, once your spectrophotometer has passed the self- tests it is 
ready to run samples. For best results you may want to let the 
spectrophotometer warm up for at least 1 hour. This time allows the 
optical system to stabilize and should result in better measurements. If the 
instrument was not stored at room temperature before it was turned on, 
allow more time for the instrument to stabilize.

In general, the life of your spectrophotometer will be increased by leaving 
it on all the time but switching off the lamps when the instrument is not 
in use. lamp intensity of the deuterium lamp and lifetime of lamps 
decrease with use.
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Starting the Agilent ChemStation Software

If Microsoft Windows is not already running, start it. If the Agilent 
UV- visible ChemStations is not visible on the Desktop, open the Start 
menu and select Agilent UV- visible ChemStations from the list of 
programs. A maximum of two sessions of an instrument can be started in 
parallel; the online session must be always the first launched session.

Two instrument icons are displayed for the Agilent UV- visible 
ChemStations:

• Instrument Online starts the software in online mode (online means 
Agilent ChemStation is connecting to the configured 
spectrophotometer). 

• Instrument Offline starts the software in offline mode (offline means 
Agilent ChemStation is not connecting to the configured 
spectrophotometer).

To start the software, click the Instrument Online or Instrument Offline 
icon in the Agilent ChemStations section.

Operational Checkout

Operational checkout is used to determine if the instrument is in proper 
operating condition in combination with your UV- visible operating 
software.

1 Be sure to verify the successful completion of the turn- on self test of 
the spectrophotometer, that is, the indicator LED on the front panel of 
the Agilent 8453 spectrophotometer is lit and is green.

2 In your UV- visible operating software, take a blank measurement and 
observe the baseline noise. With an empty sample area, this should be 
in the low mAU range. Excessive noise or spikes may indicate a 
problem.

3 For the Agilent 8453 spectrophotometer an additional (optional) 
qualification can be automatically performed using your software. After 
warm- up of the spectrophotometer for 1 hour, the instrument is ready 
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for the automated selftest which is located in the diagnostic portion of 
the software. The successful completion of these tests complete the 
operational qualification of your spectrophotometer. For reference 
purposes you may want to print a copy of the results.
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This chapter describes:

• making measurements

• selecting material, optical specification and type of cell

• handling and maintaining cells

• checklist for good results

• solvents selection,

• sample preparation,

• use of filters,

• stirring and temperature control of sample,

• how to insert cuvettes into the cell holder.
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General Considerations

There are many factors that can affect the results of your measurements. 
This section provides brief discussions of some of the more important 
ones.

Spectrophotometer Design

The sample compartment of the Agilent 8453 spectrophotometer is open. 
Unlike conventional instruments the Agilent 8453 does not suffer from 
ambient false light. The open sample area makes it easier to access it 
generally and to connect tubing to a flow cell or thermostattable cell 
holder.

Making Measurements

Blank (Reference) and Sample Measurement

Your spectrophotometer is a single beam instrument so you must measure 
a blank before you measure a sample. For the high accuracy 
measurements, the blank and the sample measurement should closely 
follow each other.

In general, a blank measurement should be repeated as often as is 
practical. Even in a thermally stable environment, a blank measurement 
should be taken every half hour to ensure accurate results.

Chemically, the only difference between the blank and the sample should 
be the presence of the analyte(s). For measurements with liquid samples, 
the blank should be a sample cell filled with the solvent you plan to use.
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Sample Cell or Cuvette Material

Quartz sample cells (cuvettes) or sample cells with quartz face plates are 
required if you want to use the full 190 to 1100 nm wavelength range of 
your spectrophotometer.

If you plan on working only in the visible and/or short- wave near- infrared 
range of 350 to 1100 nm, you can use good quality glass cells.

Disposable plastic sample cells, for measurements in the range 400 -  
1100 nm, are also available. The quality of these cells varies and they are 
generally not recommended.
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Optical Specifications of Cells

The accuracy of the readings of a diode array instrument is very sensitive 
to spatial shifts of the analysis light beam. Cells having non parallel 
opposite faces, or so called wedge shaped cells, lead to a spatial shift of 
the light beam (see Figure 6). Therefore, the opposite cell walls 
illuminated by the analysis light beam have to very parallel. The 
parallelism is measured in terms of the angle between the two opposite 
cell walls. We recommend to use 10 mm path length cells with an angle 
which is below 0.1 degrees of an arc.

Figure 6 Shift of the Instrument Light Beam due to non Parallel Cell Walls
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Apertured Cells or Cuvettes

In applications where sample volume is limited, apertured or microcells 
are used. The width of these cells is reduced to reduce the volume and 
the blank part of the cell must be blackened to avoid unwanted 
transmission and reflection through the side walls. If the side walls are 
not blackened the result will be poor photometric accuracy and, if 
different concentrations are measured, poor linearity.

The disadvantage of apertured and microcells is that part of the light 
beam is blocked. Not all the light passes through the sample and there can 
be some loss in sensitivity. See Figure 7 for recommended cells and 
Figure 8 for cells you should not use with the instrument.

Figure 7 Recommended Cells

Quartz Cells Quartz Cells with black apertures*

CAUTION * Quartz Cells with black apertures smaller than 2 mm, when used with a multicell 
transport, can lead to measurements of poor reproducibility.
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Flow Cells

We recommend a sipper system with a flow cell for obtaining the high 
precision measurements. Using a flow cell eliminates the necessity of 
moving the cell between blank measurement and sample measurement. 
Also, the cell can be rinsed thoroughly with the solution to be measured.

The design of the flow cell should minimize entrapment of bubbles and 
flow channeling to provide the most reliable results.

Figure 8 Cells You Should Not Use With the Instrument

Quartz Cells with transparent apertures,
Fluorescence Cells,
Plastic Cells
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Handling and Maintaining Cells or Cuvettes

Passivating New Cells

When filling a non passivated new cell with your sample, you will observe 
that air bubbles stick on the windows of your cell. To prevent the 
formation of sticky bubbles, rinse the cell with cleaning and passivating 
fluid (part number 5062- 8529). The cleaning procedure you should apply 
is described on the label of the cleaning fluid container.

Cleaning Cells

The fats in fingerprints are significant absorbers in the UV region and, if 
left on optical surfaces, can cause erroneous results. Wipe off all 
fingerprints and contaminants before using a sample cell.

Use only high quality lens tissues (part number 9300- 0761) and never 
dry the inside of a cell with lens tissues. Dry the inside of the cell with 
pressurized, oil free air, that prevents the cell from getting contaminated 
with tissue particles, or rinse the cell with blank or sample solution. 
Floating particles in the cell will deflect the light beam and so lead to a 
very poor quality of the measured spectrum.

Figure 9 Floating Particles in a Cell

floating particles will deflect and 
scatter the light beam
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Lens tissues for glasses or other uses often contain detergents or 
lubricants which can affect your measurements. If possible avoid cleaning 
the faces of your cell between blank and sample measurements.

Handling Cells

Always install a cell so that it faces the same direction to minimize 
problems with cell non- uniformity. For best results with microcuvettes, 
leave your sample cell clamped in position throughout the measurement 
sequence. Solutions should be removed and replaced by pipette or use 
flow cells.

Figure 10 Spectrum Taken With Floating Particles in the Light Path
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CAUTION If glass pasteur pipettes are used, make sure that the optical windows of the cell are 
not touched or scratched by the pipette.
44 Agilent 8453 UV-visible Spectroscopy System Installation Guide



Good Measurement Practices 3
General Considerations
Solvents

Your choice of solvents should be based primarily on the solvent’s 
absorbance characteristics over the wavelengths of interest, its suitability 
as a solvent for the analyte, and on experimental conditions. Table 1 lists 
common solvents and the lower limit of their useful wavelength range.

Table 1 Lower Limit of UV Transmission for Some Common Solvents

Lower Limit Solvent

180–195 nm Sulfuric acid (96%)
Water
Acetonitrile

200–210 nm Cyclopentane
n-Hexane
Glycerol
2,2,4-Trimethylpentane
Methanol

210–220 nm n-Butyl alcohol
Isopropyl alcohol
Cyclohexane
Ethyl ether

245–260 nm Chloroform
Ethyl acetate
Methyl formate

265–275 nm Carbon tetrachloride
Dimethyl sulfoxide
Dimethyl formamide
Acetic acid

280–290 nm Benzene
Toluene
m-Xylene

Above 300 nm Pyridine
Acetone
Carbon disulfide
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When using volatile solvents such as acetone or methylene chloride, make 
sure that the sample cell is stoppered. Evaporation of a solvent can 
change the solute concentration or cause solution noise due to solute 
convection currents. Both of these will affect the accuracy of your 
measurements. We also recommend stirring and temperature control when 
you use volatile solvents.

When using water as solvent we recommend using UV grade or HPLC 
grade water to reduce unwanted absorbance from the water. If you are 
using the sipper/sampler system the water should be degassed to avoid 
bubble formation in the flow cell, especially if the water comes from a 
pressurized water supply.

Sample Preparation

The sample cell should be rinsed three to five times with your intended 
solvent before you fill it with the pure solvent that will be used in the 
measurement. Turning the cell upside down on a small stack of absorbent 
tissues will help remove any residual solvent. This treatment will minimize 
contamination from previous experiments.

Samples which contain colloidal dispersions, dust or other particulate 
matter should be filtered, centrifuged or allowed to settle. If not, the 
overall attenuation- of- transmittance spectrum due to light scattering 
and/or reflection will hide the spectral information from the analyte.

WARNING Many of the solvents in Table 1 are hazardous. Be sure you fully understand their 
properties before using them.
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Photosensitive Samples

A few substances are very photosensitive. They degrade or undergo 
photochemical reactions if exposed to light. This can be easily seen by a 
decrease of sample absorbance over time.

Use of Filters

The shorter wavelength, higher- energy UV light is most likely to degrade 
photosensitive samples. If you have a problem, you can selectively block 
portions of the UV spectrum with a UV cut- off filter. An optical filter 
wheel assembly with three cut- off filters is available for the 
spectrophotometer. The cut- off wavelength of the filter you choose should 
be low enough that it does not eliminate important spectral information 
but high enough that it blocks the light that could degrade your sample. If 
you use a filter with your samples, you must use the same filter when you 
make your blank measurement.

Turning the D2-Lamp off

The short wavelength radiation leading to photodegradation comes from 
the light of the D2- Lamp. For application where readings are taken at 
wavelengths above 400 nm, the D2- Lamp can be turned off. The light 
intensity supplied by the Tungsten lamp is sufficient for a good signal to 
noise ratio over the wavelength range 400 nm -  1100 nm.When using cells 
with small apertures, you should check the signal to noise ratio by making 
sample measurements under conditions of your application.

Stirring and Temperature Control

Solution homogeneity can be a problem, especially for viscous solutions. 
There are cases where, due to convection induced gradients, rapid 
absorbance changes may give irreproducible data. These changes can be 
observed spectroscopically by taking measurements with short integration 
times. To minimize convection effects keep the temperature of your sample 
the same as the cell holder or environmental temperature. Problems like 
these can also be minimized by using a thermostattable cell holder and/or 
a stirring module.
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A similar effect can occur in cases of incomplete mixing. This is especially 
true where the specific gravities or miscibilities of the solvent and analyte 
are quite different. Again, stirring is a way to prevent this kind of 
problem.

In an unstirred cell, it is sometimes possible to observe local 
photodegradation of sensitive analytes. Because the actual volume of the 
sample in the light path is very small, stirring the sample will reduce the 
time any given analyte molecule is in the light path. This minimizes the 
photodegradation and increases homogeneity. Using a flow cell with 
continuous flow can yield similar results.

Checklist for Best Results

Cell:

✔ Cell is made of quartz or glass

✔ Apertured cells has black sides

✔ Apertured cells has an aperture greater than or equal to 3 mm 

✔ Cell windows are free of fingerprints and other contamination

✔ Flow cell used instead of an apertured standard cell

Measurements:

✔ Solution in cell is free of floating particles

✔ Solution in cell and cell walls are free of bubbles

✔ Solution in cell is mixed homogeneously

✔ Blank measured on same solvent as sample

✔ Blank measurement shows a flat baseline (Figure 11 and Figure 12 
show a good and a poor baseline)

✔ Cell orientation of blank and sample measurements is the same

✔ Ideally the cell is not removed between the measurement, which means 
the cell is filled/rinsed using a pipette or a flow cell is used

✔ Time between blank and sample measurement should be short
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Figure 11 Example of a Blank on Water Showing a Good Baseline

Figure 12 Example of a Blank on Water with Bubbles Causing a Poor Baseline
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NOTE If your blank or spectra shows artifacts similar to the one in Figure 12, see “Solvents” on 
page 45 to optimize the measurement procedure.
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Inserting a Cell

Your spectrophotometer is shipped with the standard single- cell cell 
holder you first have to install in the sample compartment. This cell 
holder accommodates standard cells or flow cells. To insert a sample cell 
(cuvette) in the cell holder:

1 Move the locking lever to its up position. 2 Insert the sample cell, making sure you orient it 
correctly. The frosted (non-clear) sides of the 
sample cell should not be in the path of the light 
beam.

3 Lock the sample cell in place by pushing the 
locking lever back down.

Small volume flow cells and particularly any cells 
with less than a 2 mm aperture may require use of 
the optional adjustable cell holder. The adjustable 
cell holder helps you ensure the cells are properly 
centered in the light path.
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Many simple, mechanical/optical accessories are available to expand the 
capabilities of your Agilent 8453 spectrophotometer. This section briefly 
describes these accessories and outlines how to install them. 

The following more complex accessories with electronic components are 
available to enhance the functionality and capabilities of your 
spectrophotometer. Information about these are included with the 
accessories in separate handbooks.

• Sipper system

• Autosampler

• Multicell transport

• Peltier temperature control accessory
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Thermostattable Cell Holder

The Agilent 89054A thermostattable cell holder (see Figure 13) is a 
single- cell cell holder with a manifold around the cell. Water from a 
thermostatted water bath can be circulated through the manifold to hold 
the sample cell at a uniform temperature. Up to 1 cm open- topped cells 
and flow cells can be used in a thermostattable cell holder.

Figure 13 Thermostattable Cell Holder

Tubing connector

Tubing restraint tab
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Installing a Thermostattable Cell Holder

1 Loosen the hold- down screws and remove the current sample holder 
from the sample compartment.

2 Orient the thermostattable cell holder the same way the standard cell 
holder was oriented and lower it onto the sample compartment 
mounting guides.

3 Tighten the hold- down screws.

4 Connect tubing (silicon, 3/16 inch i.d.) to the inlet and outlet of the 
manifold. It does not matter which side is used as the inlet and which 
side is used as the outlet. If necessary, route the tubing under the 
tubing restraint tab to keep it from interfering with the light beam. 
Make sure the tubing is securely attached; it expands when heated and 
if it is not secure a leak will result.

5 Insert the sample cell and lower the lever down to lock the cell in 
place. 

6 Begin pumping thermostatted water through the manifold. Wait for the 
sample cell and sample to reach thermal equilibrium before you make 
any measurements. The time required to reach thermal equilibrium will 
vary depending on the water temperature and the sample but generally 
should take about five minutes.

When the thermostattable cell holder is not in use, it is best to disconnect 
the tubing and drain the manifold.
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Cell Stirring Module 

The Agilent 89055A cell stirring module shown in Figure 14, mounts 
inside the base of the thermostattable cell holder. It provides the 
capability of magnetic induction stirring inside a standard 1 cm sample 
cell. The cell stirring module contains a plastic- encased magnetic impeller 
that can be driven by water or pressurized air. When you put a magnetic 
stirring bar (9301- 1161) into the filled sample cell, the stirring bar rotates 
in tandem with the impeller magnet, thus stirring the sample.

Figure 14 Cell Stirring Module
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Installing the Cell Stirring Module

1 Remove the thermostattable cell holder from the sample compartment.

2 Remove the three screws that hold the thermostattable cell holder to its 
base. Remove the cell holder and turn it upside- down.

3 Insert the cell stirring module into the cavity in the base of the 
thermostattable cell holder, see Figure 15.

4 Tighten the four screws (flathead, M3× 6 mm) that will hold the cell 
stirring module in place.

5 Attach the thermostattable cell holder to its base.

6 Mount the thermostattable cell holder back in the sample compartment.

Figure 15 Installing the Cell Stirring Module
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Tubing Connections and Operation

The cell stirring module can be driven by either water or air. Water is 
probably the fluid of choice because it is more easily controlled. Water 
temperature can be up to 100 ° C (212 ° F) with a maximum allowable 
back pressure of 4 bar (approximately 60 psi). If air is used to drive the 
cell stirring module, the pressure should be less than 0.3 bar 
(approximately 5 psi) when the stirrer is started. Again, the maximum 
pressure is 4 bar (approximately 60 psi).

There are several ways you can connect a water or air supply to the cell 
stirring module, see Figure 16. In all cases we recommend using 3/16 inch 
i.d. silicon tubing between the water supply and the stirring module.

• The stirring module can be used alone, without the thermostattable 
functions of the cell holder.

• The same water supply can be used to regulate sample cell temperature 
and to power the cell stirring module.
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If you need a faster stirring speed than can be obtained by connecting the 
manifold and cell stirring module in series, you can connect separate 
supplies to the manifold and stirring module.

Figure 16 Tubing Connections for a Cell Stirring Module

Table 2 Tubing Connections for a Cell Stirring Module

Connection Comment

A (in), B (out) Without stirring

C (in), D (out) Without cell thermostatting

A (in), B to D, C (out) In series with cell thermostatting

A and C (in), B and D (out) In parallel with cell thermostatting

D

B

C

A
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Long Path Cell Holder

The Agilent 89076A long path cell holder is a sample cell holder which 
can be adjusted to hold most cylindrical and rectangular sample cells with 
path lengths of up to ten centimeters. It uses the same mounting system 
as the other sample cell holders.

The long path cell holder includes built- in cell stops for accurate 
positioning of 1, 2, 5, and 10- cm sample cells.

The optical filter wheel (08451- 60302) can be mounted on the long path 
cell holder in the same way it is mounted on other cell holders, see 
“Optical Filter Wheel” on page 61 for details. However, instead of a 
screwdriver, a 2.5- mm hex wrench is required to install the optical filter 
wheel on the long path cell holder.

Figure 17 Long Path Cell Holder

Cell stops
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Installing the Long Path Cell Holder

1 Loosen the hold- down screws and remove the current sample holder 
from the sample compartment.

2 Orient the long path cell holder so that the clamps that hold the sample 
cell in place are on the right. Lower the cell holder onto the sample 
compartment mounting guides.

3 Tighten the hold- down screws.

Installing a Sample Cell

1 Position the cell stops according to the path length of the sample cell 
you will be using. For example if your sample cell is a 1- cm cell.

Figure 18 Positioning the Cell Stops for a 1-cm Sample Cell

Cell clamps

Clamp screws

Cell stops

Position cell here
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2 If your sample cell is not one of the standard lengths, position the cell 
stops as for a long path sample cell, i.e. move all cell stops in Figure 18 
to the left.

3 Because the light beam is collimated, absolute positioning of the sample 
cell is not important; however, consistent cell positioning gives more 
consistent results. The cell stops make it easier to consistently position 
your sample cells.

4 Install the sample cell between the clamps. Slide it against the cell stop. 
If your sample cell is not one of the standard lengths, position it so the 
clamps are gripping the mid- point of the cell.

5 Allow the clamps to close against the sample cell, see Figure 19. 
Tighten the four screws that hold the sample cell in place.

Figure 19 Installed 10-cm Cylindrical Cell in the Long Path Cell Holder
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Optical Filter Wheel

To achieve optimum measurement conditions, optical filters may be 
necessary for spectral measurements of photosensitive samples. Agilent 
Technologies offers an optical filter wheel assembly (08451- 60302), see 
Figure 20, which can be mounted on the standard cell holder, the 
adjustable cell holder or the thermostattable cell holder. An optical filter 
wheel with the same filters but with a different mounting can be used 
with the multicell transport, see User’s Guide of the multicell transport.

The filter wheel rotates to four different positions. Position zero is empty 
and permits 100% transmittance at all light wavelengths. Positions one, 
two and three have filters which absorb varying amounts of the UV 
spectrum. Figure 21 shows the transmission characteristics of each filter.

Figure 20 Optical Filter Wheel Assembly

Notches indicate filter number
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The choice of when to use a filter and which filter to use should be made 
only after considering all the factors that affect your measurements. If you 
decide that a filter is needed, you should choose a filter that transmits the 
wavelengths needed for analytical information and that blocks the 
wavelengths that contribute to sample degradation. Often, your final 
choice will be a compromise since sometimes even the light at the 
wavelengths of analytical interest can affect your sample.

If you do not need a filter for a group of measurements, you can move the 
filter wheel to position zero. This permits full light transmission. When 
you will not be using the filter wheel for an extended period of time you 
should remove the filter wheel assembly from the cell holder and store it 
in a clean plastic bag.

Figure 21 Transmission Characteristics of Filter Wheel Filters

Table 3 Filter Wheel Positions

Position Filter

0 None

1 UV roll-off

2 265 nm UV cut-off (at 50%T)

3 295 nm UV cut-off (at 50%T)
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The optical filters of the filter wheel must be kept clean. Dirty filters 
interfere with light transmission and lower the spectrophotometer 
performance. These filters may be cleaned with isopropanol and 
photographic lens tissues.

Installing the Filter Wheel Assembly

Installing the filter wheel assembly is fairly simple. The procedure is the 
same for all three cell holders. You will need a Phillips screwdriver to 
install the filter wheel assembly. However, if you install the filter wheel on 
the long path cell holder, instead of a screwdriver, a 2.5- mm hex wrench 
is required.

1 Remove the cell holder from the sample compartment.

2 Remove the two screws shown in Figure 22.

3 Position the filter wheel assembly clamp as shown in Figure 22. Replace 
the two screws but do not tighten them.

4 Tilt the outer edge of the clamp up slightly.

5 Bring the filter wheel assembly against the cell holder so that the clamp 
fits in the slot of the filter wheel assembly. The mounting ridges on the 

Figure 22 Installing the Optical Filter Wheel Assembly

Screw

Clamp
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filter wheel assembly should fit into the holes in the clamp. The base of 
the filter wheel assembly should be against the base of the cell holder.

6 Tighten the screws that hold the clamp.

Removing the Filter Wheel Assembly

1 Loosen but do not remove the two screws that hold the clamp.

2 Separate the filter wheel assembly from the cell holder.

3 The filter wheel clamp may be left in place or removed. In either case, 
retighten the two screws.

4 Store the filter wheel in a clean plastic bag.
64 Agilent 8453 UV-visible Spectroscopy System Installation Guide



Agilent 8453 UV-visible Spectroscopy System
Installation Guide
5
Installing the UV-visible Software

Agilent ChemStation Computer Details 66

Installing the Agilent ChemStation Using CD-ROM 69

This chapter describes about the minimum requirements which your 
computer must have, and describes what you have to do when you want 
to install the UV-Visible software on your own.

It is assumed that a supported Microsoft Windows operating system is 
already installed.
65Agilent Technologies
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Agilent ChemStation Computer Details

This section describes the PC hardware and operating system 
requirements that must be met for successful installation and operation of 
the Agilent ChemStation.

The Agilent ChemStation B.04.xx is supported on personal computers with 
an 1 GHz 32- bit (x86) processor. All PC hardware and peripherals must be 
listed in the Microsoft Windows Marketplace Tested Products List 
Hardware section. The hardware testing status is available from the 
Microsoft home page on the world wide web: 
(http://winqual.microsoft.com/HCL/Default.aspx). If your PC hardware is 
not tested, the system may not work with the supported operating system.

Minimum PC Requirements for the Agilent ChemStation

NOTE The software runs on systems with sufficient random access memory (RAM) installed. 
Depending on the usage of the system and the desired data throughput, those systems may 
not exhibit acceptable performance.

Table 4 Minimum PC Requirements

PC configuration Microsoft Windows XP Professional 32-bit 
(SP 2 or 3)
Windows Vista Professional 32-bit (SP 1 or 2)
Windows 7 Professional 32-bit (SP 1)
Windows Server 2003
Windows Server 2008 32-bit (SP 1)

Graphics resolution The recommended graphics resolutions for video 
graphics adapter are:
1024 by 768 with large fonts or 
1280 by 1024 with large fonts

Processor 1 GHz 32-bit (x86) (3 GHz for Windows Vista and 
Windows 7)

Screen resolution Super VGA (1280 × 1024)
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Scheduled Processes

Some scheduled processes like virus checking or defragmenting may cause 
instrument communication problems. Due to these problems, any 
automated measurement will be aborted. To prevent problems of this kind 
please disable any scheduled event.

Number Format

To avoid wrong values displayed or printed, the International settings 
must include the correct number format. Set the Number Format's Decimal 
Separator to "." (decimal point) in the Control Panel's International 
settings or in “Region and Settings” when using Windows 7. 

Mass storage 40 GB Hard-Disk and CD-ROM

Memory Minimum of 1 GB of RAM for UV-Visible 
ChemStation software and a single instrument. 
For Windows Vista or Windows 7 add another
1 GB for a total of 2 GB of RAM.

The minimum recommended amount of memory 
for a single- bath dissolution system (G1118AA) 
and kinetic measurements (G1117AA) is 2 GB of 
RAM. For Windows Vista or Windows 7 add 
another 1 GB of RAM for a total of 3 GB. 
Add 256 MB of RAM for each additional bath in a 
multi-bath dissolution system (G1118AA).

In all cases, an appropriate amount of virtual 
memory should be configured.

Table 4 Minimum PC Requirements (continued)

NOTE A maximum of four instruments may be interfaced to each Agilent ChemStation.

NOTE If you are upgrading from a previous version of Agilent ChemStation, you must uninstall the 
old version of ChemStation first.
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Printer

Please make sure that a default printer is configured in your Microsoft 
Windows operating system. This is done via the Control Panel application.

If no default printer is configured then following problems may occur:

• the 'Copy To Clipboard' menu will have an error

• in the 'Custom Report View' there are problems with new templates

• the 'print preview' doesn't work
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Installing the Agilent ChemStation Using CD-ROM

Overview

This section explains how to use the Agilent Technologies UV- visible 
ChemStation Software Products CD- ROM to:

• install the Agilent ChemStation for the first time

• upgrade/repair an existing Agilent ChemStation software

• install an additional Agilent ChemStation module

Uninstalling Preexisting Agilent UV-Vis ChemStation Software

To remove all analytical ChemStation software from your hard disk:

1 Insert your Agilent Technologies UV- visible ChemStation Software 
Products CD- ROM into the drive.

2 Run the setup program on CD- ROM.

3 Select Remove and then click Next.

Note that the removal of ChemStation software can also be done from 
within the Control Panel.

NOTE Agilent UV-Vis ChemStation B.04.xx is only supported on Microsoft Windows XP 
Professional 32-bit (SP2 or SP3), Windows Vista Professional 32-bit (SP1 or SP2), Windows 
7 Professional 32-Bit (SP1), Microsoft Server 2003, and Microsoft Server 2008 32-bit (SP1)

NOTE Local Administrator rights on the target PC are required to perform the installation.

NOTE Only files installed by the product CD-ROM are removed. All additional files such as method 
and data files are not automatically removed. By default they are located in the respective 
instrument directory C:\Chem32\1.
Agilent 8453 UV-visible Spectroscopy System Installation Guide 69



5 Installing the UV-visible Software
Installing the Agilent ChemStation Using CD-ROM
During the installation some of your configuration files will be changed. If 
you don't intend to use any ChemStation software you can remove the 
ChemStation.ini file located in the operating system folder, C:\Windows by 
default.

Installation Procedure

Use the following procedure if you are using the CD- ROM to install or 
upgrade the Agilent ChemStation.

Before installing the software:

• Set up the computer hardware.

• If GPIB communication shall be used, interface as described in 
“Installing an GPIB Interface” on page 81 (not required for LAN 
communication).

• Make sure an operating system, supported by your revision of the 
Agilent UV- visible ChemStation software, is available on the target PC.

1 Insert Agilent UV- visible ChemStation Products CD- ROM into the 
CD- ROM drive.

2 From the Start menu in the taskbar, select Start / Run.

3 At the command line, type diskdrive:\Setup.exe (for example, D:\
Setup.exe), then click OK.

NOTE If the Security Pack had been installed, please see your manual Agilent ChemStation 
Security Pack for UV-visible Spectroscopy - User's Guide for details.
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4 Please read the licence agreement and press YES to accept.

NOTE Using Windows Vista or Windows 7 you may get the warning dialog below several times 
during the installation. 

Press RUN to continue.
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5 Use the default installation path C:\Chem32 then press NEXT. (Drive 
letter can be changed from C drive to another drive if desired.)

6 Select the additional modules you want to install and press NEXT.

Note that the Security- Pack Add- On and the ECM Add- On are mutually 
exclusive. One or the other can be installed, but not both.

7 Enter the License Registration Number for each selected module in the 
entry line and press Add License. When all required licenses are added, 
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press NEXT.

The applicable product and license numbers are printed on your 
Software Certificate and Registration Packet (see the example license 
registration label).

Figure 23 Example License Registration Label

SOFTWARE REGISTRATION LABEL FOR
PRODUCT NUMBER

REVISION CODE

REGISTRATION
NUMBER

G1115AA

A.08.01

DU08E7777ASAMPLE
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8 The configuration editor will open automatically as part of setup. Adjust 
the configuration if desired -  the default is for GPIB communication 
from the PC to the 8453. Save the configuration and exit the 
configuration editor. Setup will then continue.

9 Press Finish to complete the setup and reboot your system.

Monitor Configuration

If you have a monitor with a 800×600 pixel resolution, use small fonts, 
whereas for a monitor with a 1024×768 or higher resolution, you may 
select a larger font. The font size is available with the control panels’s 
Display settings. In the Display properties dialog box use the Appearance 
tab for the adjustment.

NOTE If you selected the G3770AA ECM access module, please make sure to establish you ECM 
access using the Internet Explorer before you first launch you UV-visible ChemStation.
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Configuring Your System

The setup program configures the system automatically for your 
Agilent 8453 spectrophotometer as Instrument 1, with an GPIB address of 
25.

If you wish to use LAN communication, a different GPIB address, set up 
an additional spectrophotometer, or set up an temperature control 
accessory you must configure the system. 

To configure your system:

1 In the Agilent ChemStation group start the Agilent UV-Visible 
Configuration Editor.

2 Choose Instruments from the Configure menu. 

• The Instrument Type box lists the instrument types available on your 
Agilent ChemStation. Select one to begin your configuration. 

• Enter the name you want to call the instrument in the Instrument 
Name box. The Agilent ChemStation will use this name to identify the 
instrument. 

• Select Normal under Initial Screen Window Size to have your instrument 
session window appear as a full screen but with an open area across 
the bottom for icons. If you select Icon or Full Screen, the instrument 
session window will start as an icon or as a full screen. 

• Choose OK to enter your selections and to display the Instrument 
Name -  Device Configuration. 

• To modify settings in an existing instrument configuration, you must 
select the modul first in the Selected Modules frame and press the 
Delete button.

• Select the modul in the Modules frame and chose the type of 
interfacing.

• In case of GPIB connection, select the GPIB option. The GPIB address 
is adjusted using the scrollbar. The available GPIB addresses are 
displayed in the box. The spectrophotometer and accessories are 
shipped with the following default GPIB addresses:

GPIB Address Instrument/Accessory Name

25 Agilent 8453 spectrophotometer, or

20 Temperature control accessory
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Press Add to add the module to the list of Selected Modules.

• In case of a LAN connection, select LAN option and press Add. In the 
upcoming dialog select Identify by Host Name or Identify by IP Address and 
enter the selected information -  Host Name: or IP Address: -  in the 
entry field. Press OK to add the module to the list of Selected Modules.

• Press OK to complete the instrument configuration.

If you configure more than one instrument, you must take care that 
each instrument has a unique GPIB or LAN address. You can configure 
up to four spectrophotometers.

3 Choose OK to enter your selections and to return to the main menu.

4 If you want to change the color of a screen element:

Choose Colors from the Configuration menu, select that element under 
Screen Elements, then select a color from those shown below in the 
Standard Colors or Custom Colors list box. Your changes will appear in the 
Screen Elements list box. You can create custom colors and add these, 
use the Add Custom Colors... button and follow the instructions available 
with the Help.

5 Select and configure the GPIB interface.

For GPIB communication in the configuration dialog in the GPIB Card: 
field hp82341 must be selected.

Choose OK to save changes and return to the Configuration Editor 
display.

6 If you want to add new instruments:

Choose Add New Instrument from the Add/Delete menu to add a new 
instrument window to the Configuration Editor screen. Follow the above 
procedure to configure the instrument. Choose Delete Instrument from 
the Add/Delete menu to remove an instrument from the configuration. 
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7 Choose Save from the File menu to save your configuration. 

8 Choose Exit from the File menu to close the Configuration Editor. 

9 To set parameters for the accessories you have installed and configured, 
refer to the online help in the UV- Visible ChemStation software. 

Autosamplers

If you have an Agilent XY autosampler or an autosampler from Gilson 
International, your Agilent ChemStation software requires a special driver 
and a cable. See the readme.txt for further information.
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GPIB Communication

IEEE- 488 is a short- range, digital communications bus specification that 
has been in use for over 30 years. Originally created for use with 
automated test equipment, the standard is still in wide use for that 
purpose. IEEE- 488 is also commonly known as HP- IB (Hewlett- Packard 
Instrument Bus) and GPIB (General Purpose Interface Bus).

GPIB communication can be used to control Analytical instruments by 
means of a controller. The Agilent 8453 spectrophotometer and the 
optional Peltier Temperature Station 89090A have build- in GPIB 
interfaces.

PCs are the common controllers today. Most PCs do not offer a GPIB 
interface by default. However, such interfaces can be added. Two different 
types of interfaces are supported by the UV- visible ChemStation software: 
the PCI interface board Agilent 82350A/B and the USB to GPIB converter 
interface 82357A/B.

To configure the GPIB interface on the PC and provide the interface 
driver for the PC’s operating system, the Agilent IO Libraries Suite 16.1 is 
required.

The following steps are required to setup GPIB communication:

1 Installing an GPIB Interface 81

2 Connecting the intrument(s) with the controller: GPIB Cabling 82

3 Installation of the Agilent GPIB Communication Library 84

4 Configuration of the GPIB interface:
Configuring the Agilent 82350 GPIB Interface 88
Configuring the Agilent 82357 USB -  GPIB Interface 94

5 Configuring an Agilent 8453 Spectrophotometer 136
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Operating System-Instrument Compatibility

The Agilent 82350A/B GPIB interface PCI card and the Agilent 82357A/B 
USB to GPIB interface are supported on Windows XP, Windows Vista or 
Windows 7.

The Agilent 82350 is a PCI GPIB interface card; no additional settings on 
the interface card such as changing the I/O base address are required.

The Agilent 82357A/B USB to GPIB interface is connected to and powered 
by one of your PC’s USB connectors.

Installing an GPIB Interface

Since Peripheral Component Interconnect (PCI) interface boards can be 
installed in several different computers, the following instructions are 
general. If you have difficulties during the installation, consult your 
computer manual or dealer.

1 Turn off and unplug your computer, then remove the computer’s 
cover(s).

2 Select the appropriate empty slot for your GPIB card. The 82350A/B 
plugs into any PCI slot.
It is best not to place the GPIB board next to a graphics interface. As 

NOTE The Agilent 82341C ISA GPIB interface is not supported by Agilent ChemStations, revision 
B.04.xx or higher. 

NOTE The Agilent 82357A/B USB to GPIB interface is connected to one of your PC’s USB 
connectors. This does not require opening your PC.

WARNING Turn off and unplug your computer and all attached electrical devices before 
removing any covers.
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the GPIB connector is wider than a typical PC slot, you may have to 
leave the slot(s) adjacent to the GPIB interface empty.

3 Loosen the mounting screw and remove the selected empty slot’s rear 
plate.

4 Holding the board by its edges, insert the board into its slot. Make 
certain that the board’s edge connector is fully seated. Lock the board 
into place with the mounting screw.

5 Replace the computer's cover(s). Plug in, and restart the computer.

GPIB Cabling

When connecting GPIB devices together, there are several basic rules that 
should be observed.

1 Whenever possible, turn off and unplug the computer and all attached 
devices before the GPIB cables are installed.

2 Before connecting any analytical instrument to an GPIB cable, consult 
the documentation supplied with each device and determine its GPIB 
address. No two devices including the PC connected to a GPIB interface 
may have the same address. Alter their addresses as necessary to avoid 
any duplication. Write down each GPIB address. This information will 
be needed later.

3 Try to use short GPIB cables that are two meters long or less.

4 GPIB cable (0.5 m) (10833D)
GPIB cable (1.0 m) (10833A)
GPIB cable (2.0 m) (10833B)
GPIB cable (4.0 m) (10833C)

5 Connect one end of an GPIB cable to the computer’s GPIB connector or 
use the USB GPIB converter interface to connect to the first 
instrument.

6 Be certain that you properly tighten all GPIB connectors. A poor 
connection causes errors which are difficult to diagnose.

7 Connect GPIB devices in a chain. A chain occurs when an GPIB device 
is connected to the next GPIB device, and it is, in turn, connected to 
the next, and so on. Avoid star configurations (connecting all of the 
devices to a central point).
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NOTE The Agilent 82357A/B USB to GPIB interface has an integrated 2.5 m cable and an GPIB 
connector. In a single instrument configuration no additional GPIB cable is required (see 
Figure 39 on page 95).

WARNING According to the IEEE 488 specification for the General Purpose Instrument Bus 
(GPIB), the bus is not designed for dynamic configuration. Cycling power on an GPIB 
instrument that is connected to the bus while other GPIB instruments are actively 
communicating to the GPIB controller can induce electrical spikes that may 
potentially corrupt the GPIB protocol. In extreme cases. this may require cycling 
power on all instruments, including the GPIB controller (that is, typically the Agilent 
ChemStation).
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Installation of the Agilent GPIB Communication Library

Installing New IO Libraries 

1 Turn the Computer on and logon.

2 Use the Windows Explorer, locate and run Setup.exe in the \GPIB 
directory of your UV- visible ChemStation CD- ROM.
Follow the instructions in the installation Wizard. This will install the 
Agilent IO Libraries Suite on your computer, update the registry and 
add a new Program Group called “Agilent IO Libraries Suite”
.

NOTE Local administrator rights are required to perform the setup and configuration of the Agilent 
GPIB I/O Library.

NOTE Windows Vista or Windows 7 may request your permission to continue.
Press the Run button to continue.

Figure 24 Windows Vista and Windows 7 Security Warning
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The InstallShield Wizard prepares for the installation and displays its 
Welcome dialog.

Figure 25 Agilent IO Libraries Suite Installation Welcome Screen

3 Press the Next button to continue and select I accept the terms of the license 
agreement.

Figure 26 Agilent IO Libraries Suite License Agreement
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4 Press the Next button to continue and select Typical for the Setup Type.

Figure 27 Agilent IO Libraries Suite Setup Type Selection

5 Press the Next button to continue and press the Install button on the 
summary screen.

Figure 28 Agilent IO Libraries Suite Installation Summary
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6 A window with feature explanations and the progress window below 
will be displayed.

Figure 29 Agilent IO Libraries Suite Installation Progress

7 Press the Finish button to complete the setup.

Figure 30 Agilent IO Libraries Suite Completion Dialog

As a result of your installation you should see the IO library icon on 
the Windows task bar.

Figure 31 Agilent IO Libraries Suite Quick Launch Icon
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Configuring the Agilent 82350 GPIB Interface

• To configure your 82350 GPIB Interface, the Agilent IO Libraries Suite 
must be installed. See “Installation of the Agilent GPIB Communication 
Library” on page 84 for details.

• The 82350 PCI GPIB interface must be installed in your PC. See 
“Installing an GPIB Interface” on page 81 for hints.

NOTE If the Found New Hardware Wizard appears and the Agilent IO Libraries Suite is not 
installed, press the Cancel button.

NOTE Local administrator rights are required to configure your interface.
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1 Boot your PC, a tool tip will notify about new hardware and the Found 
New Hardware Wizard will start. Select Option 2 and click Next (see 
Figure 32)

Figure 32 Found New Hardware Wizard (Windows XP)
Agilent 8453 UV-visible Spectroscopy System Installation Guide 89



6 GPIB Communication, Connections and Configuration
Configuring the Agilent 82350 GPIB Interface
2 Select Option 2 and click Next (see Figure 33).

3 Select 82350 PCI and click Next (see Figure 34). The installation of the 
device driver will start.

.

Figure 33 Install Hardware Device Drivers

Figure 34 Select a Device Driver
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4 Select Finish (see Figure 35).

The user will get a notification by the task bar that the hardware is 
installed and ready to use. 

Figure 35 Finish Installation GPIB card
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5 Start the IO Config Utility by clicking in the IO Icon   and 
choose Agilent Connection Expert.

6 Uncheck Show this window at startup and press Close Welcome Screen. The 
Agilent Connection Expert Main Window is displayed (see Figure 36).

7 In the Agilent Connection Expert main window select GPIB0 (see 
Figure 37).

Figure 37 Agilent 82350 default settings.

Figure 36 IO Libraries Configuration
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8 Press the Change Properties... button. In the Agilent 82350 PCI GPIB 
Interface -  GPIB0 dialog window select or enter the following 
properties:
VISA interface ID: to GPIB0,
GPIB address: to 30,
check System controller (recommended),
SICL Interface ID: to hp82341,
Logical unit: to 7 or 9 and
uncheck Auto-discover instruments connected to this interface (see Figure 38).

Figure 38 Agilent 82350 Interface configuration.

.

9 Select OK. The configured GPIB board should now appear as GPIB0 in 
the list of Instrument I/O on this PC with a yellow warning symbol with an 
exclamation mark. Use the File menu’s Exit command and in the 
upcoming dialog press the Reboot Now button.
After the reboot your GPIB library installation is complete.

NOTE The appearance of the dialog slightly differs depending on the type of GPIB board installed.

NOTE You need to type in the SICL interface ID hp82341 with lower case letters.
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Configuring the Agilent 82357 USB - GPIB Interface

• To configure your 82357 USB- GPIB Interface, the Agilent IO Libraries 
Suite must be installed. See “Installation of the Agilent GPIB 
Communication Library” on page 84 for details.

• A USB 1.0 or 2.0 connection on your PC must be available.

NOTE Local administrator rights are required to configure your interface.
94 Agilent 8453 UV-visible Spectroscopy System Installation Guide



GPIB Communication, Connections and Configuration 6
Configuring the Agilent 82357 USB - GPIB Interface
1 Plug the 82357A/B USB- GPIB Interface into the GPIB connector of the 
instrument’s GPIB connector.

2 Connect the USB connector of the 82357 USB- GPIB interface into a 
USB port of your Computer. The hardware wizard detects a USB device 

NOTE If a GPIB cable is used to interconnect multiple modules (e.g. 89090A Peltier Temperature 
controller) the USB Interface device needs to also be plugged into the GPIB connector (see 
Figure 39).

Figure 39 82357 USB-GPIB Interface on e.g. 8453 spectrophotometer
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and the Found New Hardware Wizard will start (see Figure 40).

3 Select Option 1 and click Next and the installation will start (see 
Figure 40).

Figure 40 Found New Hardware Wizard Windows XP, first detection
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4 To initialize the interface select Option 1 and click Next and the 
initialization will start (see Figure 41).

5 The system will initialize the USB device. This might take some seconds 
(see Figure 42).

Figure 41 Found New Hardware Wizard Windows XP, first detection

Figure 42 Initializing the 82357A USB-GPIB Interface in Windows XP, first detection
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6 Select Finish to close the wizard after the initialization Hardware driver 
(see Figure 43). The initialization of the USB device is finished, the 
installation still needs to be done. 

Figure 43 Finish Device Driver Installation in Windows XP
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7 The hardware wizard detects now the USB- GPIB device for a second 
time and the Found New Hardware Wizard starts again (see Figure 44).

8 Select Option 1 and click Next (see Figure 44).

9 Select Option 1 and click Next to start the installation (see Figure 45)).

Figure 44 Found New Hardware Wizard Windows XP, second detection

Figure 45 Found New Hardware Wizard Windows XP, second detection
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10 The system initializes the 82357A USB- GPIB Interface device. This 
might take some seconds (see Figure 46)). Please wait until the 
configuration screen appears, see step 14.

Figure 46 Installing the 82357A USB-GPIB Interface in Windows XP, second detection

NOTE The hardware installation warning may appear. In such a case press the Continue Anyway 
button.

Figure 47 Hardware Installation warning.
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11 Press the Finish button to complete the hardware setup.

Figure 48 Hardware Wizard completion.
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12 Start the IO Config Utility by clicking in the IO Icon   and 
choose Agilent Connection Expert.

13 Uncheck Show this window at startup and press Close Welcome Screen. The 
Agilent Connection Expert Main Window is displayed (see Figure 49).

Figure 49 Agilent Connection Expert Main Window 82357 USB-GPIB interface
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14 In the Agilent Connection Expert main window select USB/GPIB (GPIB0)

Figure 50 Agilent 82357 default settings

15 Press the Change Properties... button. In the Agilent 82357 Interface 
Converter -  USB/GPIB dialog window select or enter the following 
properties:
VISA interface ID: to GPIB0,
GPIB address: to 30,
SICL Interface ID: to hp82341,
uncheck Auto-discover instruments connected to this interface (see Figure 51)

Figure 51 Agilent 82357 Interface configuration
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16 Select OK to close the interface configuration dialog and use the File 
menu’s Exit command to quit the Agilent Connection Expert.
Your GPIB library installation and 82357 interface configuration is 
complete.

NOTE The appearance of the dialog slightly differs depending on the type of USB-GPIB converter 
interface.

NOTE You need to type in the SICL interface ID hp82341 with lower case letters.
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Upgrading Existing IO Libraries 

Upgrading IO Libraries under Windows XP

Follow the installation procedure described “Installing New IO 
Libraries” on page 84. The existing library will be automatically removed.
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Working with your Agilent IO Libraries

For details about the Agilent IO Libraries Suite please refer to the 
additional documentation provided.

To access the documentation, click on the IO Icon  of the 
notification area of the Taskbar, choose Documentation and select the 
type of information you need (see Figure 52).

Figure 52 Agilent IO Libraries Suite Documentation access.
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Troubleshooting

Missing files during installation

During installation is might be possible that the system is looking for 
some IO installation files which are not copied during the installation 
process. In this case the repair option of the Agilent IO Libraries Suite 
should be used.

1 Start the Control Panel’s Add or Remove Programs dialog.

2 In the Add or Remove Programs dialog select Agilent IO Libraries Suite and 
press the Change/Remove button. After a few seconds of preparation the 
Agilent IO Libraries Suite - InstallShield Wizard is displayed (see Figure 53).

Figure 53 Agilent IO Libraries Suite InstallShield Wizard
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3 Select the Repair option and press Next. Wait until the repair process is 
finished.

4 Press Finish to complete the repair (see Figure 54).

Figure 54 Agilent IO Libraries Suite Maintenance complete.
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Problems with Plug and Play option GPIB cards

Operation systems using Plug and Play may show problems during the 
installation of the appropriate drivers for the GPIB (PCI) cards.

In order to overcome plug and play related problems please follow the 
steps to install the card successfully.

1 If already installed, un- install the Agilent IO Libraries from Control Panel, 
Add/Remove Programs.

2 Remove the GBIB Interfaces (if installed) listed under the Device 
Manager and shut down the computer. 
Control Panel, double- click System, Hardware Tab, 
Device Manager, GPIB Interfaces 

3 Physically remove the GPIB card from the computers PCI Interface.

4 Restart the computer and log on to the system. Install the Agilent IO 
Libraries Suite.
Do not configure the card this time and shut down the computer.

5 Install the GPBI card again and turn on the computer -  the new 
hardware found wizard will indicate that a PCI card is found. Select the 
second choice to search from a list of known devices and there select 
the option for Agilent Technologies, since the IO Libraries are already 
installed.
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6 If the new hardware wizard does not run, check the device manager to 
verify that the GPIB interface is listed and installed correctly. 

7 To configure the GPIB card please follow the instructions stated in 
“Configuring the Agilent 82350 GPIB Interface” on page 88 or 
“Configuring the Agilent 82357 USB -  GPIB Interface” on page 94.

Figure 55 Device Manager GPIB Interfaces
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Changing the GPIB Address of the Spectrophotometer

This section describes how to set/change the GPIB address of the Agilent 
8453 spectrophotometer.

The connector for the interface is located on the rear panel of the 
spectrophotometer. Next to the connector is an address and control switch 
module. This module is shown in (see Figure 56).

The address switches are set at the factory to a default GPIB address of 
25 (in fact, the binary equivalent of 25).

To change the GPIB address of your Agilent 8453 spectrophotometer:

1 Turn- off your spectrophotometer.

2 On the spectrophotometer’s configuration switch module, make sure 
switches 1 and 2 are in the down position for GPIB address definition 
and set the switches 3 through 8 for the appropriate address, see 
Table 5.

NOTE GPIB addresses are only applied in configurations using GPIB connection to the 8453 
spectrophotometer.
In a LAN connection the GPIB address is not used.

NOTE The GPIB address 25 is also used as the default in the installation of the UV-visible 
ChemStation software.

Figure 56 Configuration Switch Module

1 2 3 4 5 6 7 8
Agilent 8453 UV-visible Spectroscopy System Installation Guide 111



6 GPIB Communication, Connections and Configuration
Changing the GPIB Address of the Spectrophotometer
3 Remove any objects (for example, cuvettes, flow cells) from the light 
path and turn on the line power to the spectrophotometer. This action 
stores the GPIB address in the non- volatile memory.

The address will remain unchanged in the non- volatile memory until a 
new address is set on the DIP switches and the instrument is 
power- cycled again.

CAUTION Make sure that the GPIB address does not conflict with other instruments connected 
to the same GPIB controller and the GPIB address of the controller itself.
In our configuration the GPIB address 30 is used for the controller.
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GPIB Address Settings

Use Table 5 and Table 6 to find the switch settings for the GPIB address 
of your Agilent 8453 spectrophotometer.

Table 5 GPIB Address Switch Settings (Addresses 0 Through 15)

Address 1 2 3 4  5 6 7 8

0 0 0 0 0 0 0 0 0

1 0 0 0 0 0 0 0 1

2 0 0 0 0 0 0 1 0

3 0 0 0 0 0 0 1 1

4 0 0 0 0 0 1 0 0

5 0 0 0 0 0 1 0 1

6 0 0 0 0 0 1 1 0

7 0 0 0 0 0 1 1 1

8 0 0 0 0 1 0 0 0

9 0 0 0 0 1 0 0 1

10 0 0 0 0 1 0 1 0

11 0 0 0 0 1 0 1 1

12 0 0 0 0 1 1 0 0

13 0 0 0 0 1 1 0 1

14 0 0 0 0 1 1 1 0

15 0 0 0 0 1 1 1 1

WARNING Switches 1 and 2 are used for factory firmware settings. Do not change these 
switches. Any changes could result in instrument failure. To recover, set switches 1 
and 2 to position 0 and power-cycle the instrument. For more detailed information, 
see the Service Manual.
Agilent 8453 UV-visible Spectroscopy System Installation Guide 113



6 GPIB Communication, Connections and Configuration
Changing the GPIB Address of the Spectrophotometer
Table 6 GPIB Address Switch Settings (Addresses 16 Through 31)

Address 1 2 3 4  5 6 7 8

16 0 0 0 1 0 0 0 0

17 0 0 0 1 0 0 0 1

18 0 0 0 1 0 0 1 0

19 0 0 0 1 0 0 1 1

20 0 0 0 1 0 1 0 0

21 0 0 0 1 0 1 0 1

22 0 0 0 1 0 1 1 0

23 0 0 0 1 0 1 1 1

24 0 0 0 1 1 0 0 0

25 0 0 0 1 1 0 0 1

26 0 0 0 1 1 0 1 0

27 0 0 0 1 1 0 1 1

28 0 0 0 1 1 1 0 0

29 0 0 0 1 1 1 0 1

30 0 0 0 1 1 1 1 0

31 0 0 0 1 1 1 1 1
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The first five sections of this chapter describe all necessary installations, 
connections and configurations of the LAN communication.

The last section of this chapter helps you if the LAN communication does 
not work properly.
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Installing and Configuring TCP/IP on the PC

If you connect your Agilent 8453 using a standard LAN connection, you 
must ensure proper communication between the PC and the instrument. 
The communication uses the TCP/IP protocol, that needs to be installed as 
a network protocol on your PC.

According to your operating system applied continue with:

• Installation of the TCP/IP protocol using Windows XP. 117

• Installation of the TCP/IP protocol using Windows Vista or Windows 
7. 120

NOTE If you are using a LAN, please make sure that no conflict arises by assigning an IP address 
to both the PC and the instrument. Ask your responsible IT consultant for help. 
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Installation of the TCP/IP protocol using Windows XP.

1 Select Start > Settings > Network Connections, right click Local Area 
Connection and select Properties.

2 In the ‘Local Area Connection Properties’ dialog (see Figure 57) click the 
Configuration button to make sure the device is working properly.

Figure 57 Local Area Connection Properties

NOTE If the device is not working properly or no network interface card is configured, please refer 
to the hardware manual of your network card and the PC for how to install and configure a 
network interface card.
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3 In the ‘Components checked are used for this connection:’ section of this dialog 
make sure the ‘Internet Protocol (TCP/IP)’ is available and checked.

4 Select the ‘Internet Protocol (TCP/IP)’ and press the ‘Properties’ button.

NOTE If the TCP/IP protocol is not installed, use the Install button, select Protocol from the list of 
network components to install and press Add. From the ‘Manufacturers:’ select 
‘Microsoft’ and from the ‘Network Protocol:’ select the ‘Internet Protocol (TCP/IP)’ and 
press ‘OK’. If required, reboot your computer.

NOTE If the PC is connected to your companies LAN, do not change any setting. Note down the 
‘Subnet Mask’ if available. Ask your responsible IT consultant for this mask if not available 
and request a fixed IP address for your instrument, if you want to use the existing LAN for 
the instrument connection.
For further details please see“Connecting Agilent 8453 Spectrophotometer(s) to the PC”. 

Figure 58 Internet Protocol (TCP/IP) Properties
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5 In the ‘Internet Protocol (TCP/IP) Properties’ dialog (see Figure 58) 
select the option ‘Use the following IP address’ and enter your computer’s 
‘IP Address’ and ‘Subnet Mask’.

a If the system is on an isolated LAN, the following defaults can be 
used: 192.168.254.10 for the PC IP address, and 255.255.255.0 for the 
subnet mask. (note: to use these defaults, DIP switches 5 and 6 on 
the LAN card must be "ON"). 

6 Turn off the Microsoft Windows Firewall and reboot the computer.

NOTE Gateway, DNS and WINS IP addresses do not need to be configured if you do not connect 
to any other part of a network. 
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Installation of the TCP/IP protocol using Windows Vista or 
Windows 7.

1 Select Start > Control Panel> Network and Sharing Center. In the Tasks list 
click on Manage network connections. In the LAN or High-Speed Internet list 
right click on your LAN adapter icon and select Properties.

2 In the ‘Local Area Connection Properties’ dialog (see Figure 59) click the 
Configure... button to make sure the device is working properly.

Figure 59 Local Area Connection Properties

NOTE If the device is not working properly or no network interface card is configured, please refer 
to the hardware manual of your network card and the PC for how to install and configure a 
network interface card.
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3 In the ‘This connection uses the following items:’ section of this dialog make 
sure the ‘Internet Protocol Version 4(TCP/IPv4)’ is available and checked.

4 Select the ‘Internet Protocol Version 4(TCP/IPv4)’ and press the ‘Properties’ 
button.

NOTE If the TCP/IP protocol is not installed, use the Install button, select Protocol from the list of 
network components to install and press Add.
From the ‘Manufacturers:’ select ‘Microsoft’ and from the ‘Network Protocol:’ select the 
‘Internet Protocol Version 4(TCP/IPv4)’ and press ‘OK’. If required, reboot your computer.

NOTE If the PC is connected to your companies LAN, do not change any setting. Note down the 
‘Subnet Mask’ if available. Ask your responsible IT consultant for this mask if not available 
and request a fixed IP address for your instrument, if you want to use the existing LAN for 
the instrument connection.
For further details please see“Connecting Agilent 8453 Spectrophotometer(s) to the PC”. 

Figure 60 Internet Protocol Version 4(TCP/IPv4) Properties
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5 In the ‘Internet Protocol Version 4 (TCP/IPv4) Properties’ dialog (see 
Figure 60) select the option ‘Use the following IP address’ and enter your 
computer’s ‘IP Address’ and ‘Subnet Mask’.

a If the system is on an isolated LAN, the following defaults can be 
used: 192.168.254.10 for the PC IP address, and 255.255.255.0 for the 
subnet mask. (note: to use these defaults, DIP switches 5 and 6 on 
the LAN card must be "ON"). 

6 Turn off the Microsoft Windows Firewall and reboot the computer.

NOTE Gateway, DNS and WINS IP addresses do not need to be configured if you do not connect 
to any other part of a network. 
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Installing the LAN Interface in your Agilent 8453 
Spectrophotometer

The JetDirect card (G1846A) and the TalkToLab card (G1369A) are the 
LAN interfaces used to physically connect the Agilent 8453 
spectrophotometer to the PC via a LAN cable. To install the LAN interface 
card:

1 Switch off the Agilent 8453 spectrophotometer.

2 Remove the metal cover at the upper right of the rear panel.

3 If the system is on an isolated LAN, the following defaults can be used: 
192.168.254.10 for the PC IP address, 255.255.255.0 for the subnet 
mask, and 192.168.254.11 for the 8453. (note: to use these defaults, DIP 
switches 5 and 6 on the LAN card must be "ON"). 

4 Plug the LAN interface card into the slot and screw down the two 
mounting screws.

WARNING Do not connect the LAN interface of your PC to the CAN interface of the Agilent 8453 
spectrophotometer, otherwise the LAN interface of the PC will be seriously 
damaged, because the operating voltage of the CAN interface (12 V) is higher than 
the operating voltage of the LAN interface (5 V).
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Connecting Agilent 8453 Spectrophotometer(s) to the PC

This section describes how to setup the connection between your 
instrument(s), and the PC. If you are going to connect to an existing LAN, 
please contact your system administrator for further assistance.

Single Instrument Installation

In a single instrument installation, only one Agilent 8453 
spectrophotometer is connected to the PC’s LAN interface. In this 
configuration, only the black 10 ft. long crossover twisted pair cable (part 
number 5183- 4649) can be used, which is supplied with the Agilent 
UV- visible ChemStation software.

WARNING Do not connect the LAN interface of your PC to the CAN interface of the Agilent 8453 
spectrophotometer, otherwise the LAN interface of the PC will be seriously 
damaged, because the operating voltage of the CAN interface (12 V) is higher than 
the operating voltage of the LAN interface (5 V).

NOTE A LAN connection requires the Agilent 8453 spectrophotometer to have firmware revision 
A.03.30 or higher.

NOTE Do not use the standard (non-crossover) Ethertwist 10BaseT cable supplied with the LAN 
interface card G1846A for direct single instrument connection.
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Multiple Instrument Installation

If you want to connect more than one Agilent 8453 spectrophotometer to 
the Agilent ChemStation PC or if the PC needs to connect to a network 
using the same network connection, a hub (for example the G2402A 8 port 
hub) is required. The hub G2402A comes with one standard EtherTwist 
10BaseT cable that is used for the connection to the PC. Use the standard 
EtherTwist 10BaseT cable (part number G1530- 61485) provided with the 
LAN interface cards to connect the hub to the spectrophotometer.

Setting the IP Address of the Agilent 8453 Spectrophotometer

The IP address of the LAN interface card inserted to the Agilent 8453 
spectrophotometer can be assigned by using the Agilent bootp service. 
This service assigns the LAN interface card with a configured IP address, 
each time an IP address is requested. Refer to the next section “Using the 
Agilent BootP Service” on page 126.

NOTE Do not use the black 10 ft. long crossover twisted pair cable (part number 5183-4649) in an 
installation with multiple instruments.

Figure 61 LAN Connection Using a Hub

Use standard twisted 
pair LAN cables for the 
connections.

Personal computer Network Hub

Instruments

NOTE  If the system is on an isolated LAN and the default IP address 192.168.254.11 for the 8453 
is used, BootP is not necessary.
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Using the Agilent BootP Service

What is the Agilent BootP Service?

The Agilent Bootstrap Protocol Service, acronym BootP Service, provides 
central administration of IP addresses for Agilent instruments on a LAN. 
The service runs on the instrument LAN PC, which must be running 
TCP/IP network protocol and cannot run a DHCP server/service or 
another BootP Service.

When an instrument is powered on, an Agilent LAN interface card in the 
instrument broadcasts a request for an IP address or Host Name and 
provides its hardware address as an identifier. The request may continue 
for up to 5 minutes. The Agilent BootP Service answers this request and 
passes a previously defined IP address and Host Name associated with the 
hardware address to the requesting instrument.

In case of the instrument on the LAN, the G1369A LAN card used to 
connect the Agilent 8453 to the LAN does not store any settings, so each 
time the instrument is powered on the card sends a request to the 
network for an IP address and setting information. The implementation of 
the BootP protocol on the G1369A LAN card conforms to RFC 951 and 
RFC 1048.

In order to provide this information to the card, the BootP Service must 
be operational before the card sends the request and the BootP Service 
must be configured to know the hardware address (also called Media 
Access Control, acronym MAC address) of the LAN interface card. Multiple 
LAN interface cards can be configured by means of a single BootP Service.

If your network is already using a BootP Service, please refer to section 
“Configuring the G1369A LAN Card Using BootP” on page 133. If you do 
not have a BootP Service, we suggest to use the Agilent BootP Service 
program supplied on the Agilent UV- visible ChemStation CD- ROM.

NOTE  If the system is on an isolated LAN and the default IP address 192.168.254.11 for the 8453 
is used, BootP is not necessary.
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Addresses

Before installing and configuring BootP Service, you must know the IP 
addresses of the computer and instruments, the subnet mask, and the 
gateway. 

Table 7 Example

Device Address

PC 10.10.10.1

8453 10.10.10.101

Subnet mask 255.255.255.0

Gateway 10.10.10.1
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Using the Agilent BootP Service Program

The Agilent BootP Service program allows configuring the LAN interface 
card. Within the Launch Manager of the program you can easily add a 
MAC address and IP address pair to the configuration. The Launch 
Manager is displaying a list of the currently configured MAC address and 
allows modification of the current configured settings.

Figure 62 Configured interfaces view of the Agilent BootP Service
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Configure the Agilent BootP Service Program

Before configuring BootP Service, you must know the IP addresses of the 
computer and instruments, the subnet mask, and the gateway. The MAC or 
hardware address of aLAN interface is a world wide unique identifier. No 
other network device will have the same MAC address. The MAC address 
is printed on the card or can be read out during the configuration 
procedure:

Determine your MAC Address

Determine the MAC address of the LAN card installed. The number is 
engraved in the board.

Write down the MAC address before installing the card into the module. 
To remove the card from the system, turn the module off before removing 
the LAN card. Read the MAC address from the label. Reinstall the card 
and turn on the module again.

NOTE  If the system is on an isolated LAN and the default IP address 192.168.254.11 for the 8453 
is used, BootP is not necessary.

NOTE If the PC has been rebooted after installing the Agilent BootP Service, the Agilent BootP 
Service is started automatically during the next startup of the system. To change BootP 
settings, the service must be stopped, the changes made, then restarted. The details are 
documented within this section.
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Using the Launch Manager

1 To add the instrument to the network go to Start > Programs > Agilent 
BootP Service>Edit BootP Settings. The BootP Settings screen appears.

2 Uncheck Do you want to log BootP requests?

3 Click Launch Manager. The BootP Manager screen appears.

4 Click Add.... The Add BootP Entry screen appears.

5 Make the following entries for your instrument:

• MAC Address

• Host Name

• IP Address

• Comment, if desired

• Subnet Mask

• Gateway Address

6 Click OK.

7 Exit Launch Manager and power cycle both the PC and the 8453.

8 Ping the IP address from a command prompt on the PC to verify.

Figure 63 Configured interfaces view of the Agilent BootP Service
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Configure the Agilent BootP Service 

BootP Service starts automatically when your PC reboots. In order to add 
an additional instrument or to change the configuration the service must 
be stopped. After the changes have been applied, the service must be 
restarted.

1 To stop the BootP service go to Start > Settings >Control Panel and select 
Administrative Tools > Services. The Services window appears.

2 Right click Agilent BootP Service.

3 Select Stop.

4 Close the Services and Administrative Tools windows.

Figure 64 Services window
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5 To edit the BootP Settings go to Start >All Programs > Agilent BootP Service 
> Edit BootP Settings. The BootP Settings screen appears. 
When this screen opens the first time, the default settings from 
installation are displayed.

6 To edit the TabFile you have to select Maintain bootp tabfile? 
The default tab file was created at installation and is located at Program 
Files\Common Files\Agilent Shared\BootP\bin\TabFile. It contains 
configuration information entered on this screen.

If necessary you can 

• change the BootPtab File Location by using the browse button on the 
right (a valid BootP tabfile must exist).

• create your own template for the tabfile by selecting Create template 
BootP tabfile? and click Create Template.

7 Check Do you want to log bootp requests?
The default log file was created at installation and is located at Program 
Files\Common Files\Agilent Shared\BootP\bin\LogFile. It contains an entry 
for every time a device requests configuration information from BootP.

If necessary you can change the BootPlog File Location by using the 
browse button on the right (a valid BootP tabfile must exist).

8 Perform your necessary changes by e.g. creating a log file entry of a 
new instrument and edit the new instrument using the Launch Manager.

9 Uncheck Do you want to log bootp requests?

10 Click OK to save the values or Cancel to discard them. The program 
ends.

11 To restart the BootP Service o to Start>Settings>Control Panel and 
select Administrative Tools>Services. The Service screen appears.

12 Right click Agilent BootP Service.

13 Select Start.

14 Close the Services and Administrative Tools screen.

15 This completes the configuration.
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Configuring the G1369A LAN Card Using BootP

In order for an internal G1369A LAN card to use BootP, the default 
setting: bootp=YES must be set. For more details please see the user 
manual of your G1369A LAN interface card.

To change the setting, the card must be reset; this is done each time the 
instrument with the G1369A LAN card inserted is power cycled.

The Agilent BootP Service uses a file called bootptab were all the 
configuration information is stored. The BootP Service program on the 
Agilent ChemStation CD- ROM allows easy editing of the bootptab file. If a 
BootP Service is already installed, the following information must be 
supplied to the system administrator to be able to correctly set up the 
bootptab file.

# CAG Bootptab file
# global defaults
global.defaults:\
sm=255.255.255.0:\
gw=<gateway address - ask your system administrator>

#8453 lab
UV-Vis:\
ht=1:\
ha=0030D30D3277:\
ip=<ip address - ask your system administrator>
sm=255.255.255.0:\
gw=<gateway address - ask your system administrator>
vm=auto:\
hn:\
bs=auto:\
T145=64:T146=01:T147=01
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The entries are described below

• #8453 lab
Comment line starting the configuration set for an Agilent 8453 
spectrophotometer. A comment is preceded with #; all characters after 
the # on the same line are ignored by the BootP Service.

• UV-Vis:\
Host name of the instrument. The host name communication can only 
be used if a DNS server (Domain name server) is correctly set up for 
the name or a corresponding entry in the HOSTS file exists (windows\
system32\drivers\etc\hosts).

• ha=0030D30D3277:\
This is the hardware or MAC address of the G1369A LAN card. It is 
usually printed on a label attached to the card. If not, see section 
“Determine your MAC Address” on page 129.

• ip=<IP address - ask your system administrator>
This is the IP address that will be assigned to the card after the BootP 
request. This IP address must be configured using the Agilent 
ChemStation Configuration Editor.

• sm=255.255.255.0:\
This is the subnetmask assigned by the BootP request.

• gw=<gateway address - ask your system administrator>
This is the gateway address assigned by the BootP request.

• T145=64:T146=01:T147=01
These parameters configure the buffer handling of the G1369A LAN 
card. These are required for the instrument on the LAN to work 
properly and must not be changed.

Different entries for the subnet mask and default gateway might be 
required, depending on your network setup. These values need to be set 
by your network administrator.
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Using the Agilent ChemStation Configuration Editor to Configure 
the Agilent 8453 Spectrophotometer

What is the Agilent ChemStation Configuration Editor?

The Agilent ChemStation Configuration Editor is a program that allows 
the easy configuration of your Agilent UV- visible ChemStation software. 
This includes

• Detecting the GPIB interface in your PC

• Selecting communication using LAN or GPIB

• Configuring the analytical hardware connected to the PC.

• Configuring the paths used for data storage.

• Configuring color display of the Agilent ChemStation.

Since the Configuration Editor modifies the internal communication 
module database, the Agilent UV- visible ChemStation must be closed 
beforehand.

NOTE If LAN connection is used, Microsoft TCP/IP protocol must be installed and configured, the 
LAN interface Card must be installed, the Agilent 8453 spectrophotometer has to be 
connected to the PC, and a bootp server must be installed and configured before the 
spectrophotometer(s) can be used. See “Installing and Configuring TCP/IP on the PC” on 
page 116 for details.
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Configuring an Agilent 8453 Spectrophotometer

This section describes how to configure an Agilent 8453 
spectrophotometer for LAN communication.

1 Start the Agilent ChemStation Configuration Editor by double- clicking 
on the Configuration Editor icon in the UV- visible ChemStation start- up 
group, by choosing Start > All Programs > UV-Visible ChemStations > UV-Vis 
Configuration Editor.

2 Select the Configure- >Instruments menu.

3 Select the Instrument Type UVVis, enter an Instrument Name for your 
configuration (e.g. Agilent 8453 UV-Visible System [1]), choose an Initial 
Screen Window Size, and select OK.

Figure 65 Instrument configuration dialog.
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4 If GPIB communication has been setup for the spectrophotometer, the 
following screen will come up (25 is the default GPIB address).

Figure 66 Device configuration dialog (GPIB interfacing)

In this case select the Spectrophotometer 8453 - GPIB 25 entry in the 
Selected Modules tab and click on Delete to delete the selected module.

5 Select Spectrophotometer 8453 in the Modules tab, mark the LAN radio 
button, and click on Add to add to the Selected Modules box.

6 Select Identify by IP Address and type in the IP address of the LAN 
interface card. (If a DNS server is installed you can also define the host 
name.)
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7 Select OK to exit and to return to the Device Configuration dialog box, 
which now should look like this:

Figure 67 Device configuration dialog (LAN interfacing)

8 Select OK to exit the Device Configuration dialog box and save your 
configuration changes by selecting File > Save.

9 Exit the Configuration Editor by selecting File > Exit. 

10 Reboot the PC and power cycle the 8453. 

11 Wait until the front panel LED on the 8453 turns green. Then start the 
Agilent ChemStation to check if the software communicates with the 
spectrophotometer. In case the red error message line Power Fail shows 
up, refer either to the following troubleshooting section or repeat the 
installation procedure.
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Troubleshooting LAN Communication

Power fail reported on the Agilent ChemStation

If your Agilent ChemStation can not connect to the spectrophotometer 
using LAN communication, please perform the following troubleshooting 
steps.

Verify that basic communication is possible

Use the ping command, to verify that the IP address is operational.

1 From the Start menu in the taskbar, select Start > Run.... In the Open: 
field type cmd.exe and press Enter.

2 Type ping <IP-number> and press Enter to verify communication of the 
LAN Interface Card and the LAN interface in your PC. <IP- number> 
needs to be replaced by the appropriate IP address (e.g. 10.10.10.101) 
or host name.

3 The command ping will send a request for reply to the IP address, 
bypassing part of the Windows TCP/IP settings. A successful ping would 
look like this:

Reply from 10.10.10.101: bytes=32 time<10ms TTL=128

If the message request timed out is displayed, the IP address can not be 
reached by the ping command.

4 If the ping request was answered successfully by the instrument, you 
need to verify that your Windows TCP/IP settings are correct for the 
selected network, especially the subnet mask and gateway settings 
should be checked.

Identify by host name

If you identify the Agilent 8453 system by host name, ensure that the used 
host name and IP address are correctly setup in the DNS server. Try using 
the IP address in the Configuration Editor.
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Verify that the LAN Interface card is correctly configured

To ensure that all parameters of the LAN interface card are set correctly, 
use the Agilent BootP Service program from the 
Agilent UV- visible ChemStation CD- ROM and disable any other means that 
configure the LAN interface card of the instrument. Install the bootp 
service as described in section “Using the Agilent BootP Service” on 
page 126 and configure it for the MAC address of the LAN interface card.

DHCP server

Make sure that no DHCP server runs in the same subnet as the 
instrument(s), as these servers also may respond to a bootp request and 
do not set the buffer handling of the LAN interface card correctly, i.e. 
T145=64:T146=01:T147=01. They also may assign a different IP address to 
the instrument each time it is started.

Frequent buffer overrun in Agilent 8453 logbook

Please contact your system administrator, to check if the network is not 
capable of the network traffic induced due to the data acquisition of the 
instrument(s). This can also be caused by an incorrectly configured buffer 
handling of the LAN interface card (correct settings: 
T145=64:T146=01:T147=01).

NOTE If a DHCP server is running in the same subnet, make sure that fixed IP addresses are 
reserved for your instruments. Ask you IT consultant to make sure that no IP address 
conflict may occur.
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Safety Information

The following general safety precautions must be observed during all 
phases of operation, service, and repair of this instrument. Failure to 
comply with these precautions or with specific warnings elsewhere in this 
manual violates safety standards of design, manufacture, and intended use 
of the instrument. Agilent Technologies assumes no liability for the 
customer’s failure to comply with these requirements.

General

This is a Safety Class I instrument (provided with terminal for protective 
earthing) and has been manufactured and tested according to 
international safety standards.

Operation

Before applying power, comply with the installation section. Additionally 
the following must be observed.

Do not remove instrument covers when operating. Before the instrument is 
switched on, all protective earth terminals, extension cords, 
auto- transformers, and devices connected to it must be connected to a 
protective earth via a ground socket. Any interruption of the protective 
earth grounding will cause a potential shock hazard that could result in 
serious personal injury. Whenever it is likely that the protection has been 
impaired, the instrument must be made inoperative and be secured against 
any intended operation.

Make sure that only fuses with the required rated current and of the 
specified type (normal blow, time delay, and so on) are used for 
replacement. The use of repaired fuses and the short- circuiting of 
fuseholders must be avoided.
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Some adjustments described in the manual, are made with power supplied 
to the instrument, and protective covers removed. Energy available at 
many points may, if contacted, result in personal injury. 

Any adjustment, maintenance, and repair of the opened instrument under 
voltage should be avoided as much as possible. When inevitable, this 
should be carried out by a skilled person who is aware of the hazard 
involved. Do not attempt internal service or adjustment unless another 
person, capable of rendering first aid and resuscitation, is present. Do not 
replace components with power cable connected.

Do not operate the instrument in the presence of flammable gases or 
fumes. Operation of any electrical instrument in such an environment 
constitutes a definite safety hazard.

Do not install substitute parts or make any unauthorized modification to 
the instrument.

Capacitors inside the instrument may still be charged, even though the 
instrument has been disconnected from its source of supply. Dangerous 
voltages, capable of causing serious personal injury, are present in this 
instrument. Use extreme caution when handling, testing and adjusting.

Safety Symbols

Table 8 Safety Symbols used on Instruments and in Manuals

Symbol Description

The apparatus is marked with this symbol when the user should refer to the 
instruction manual in order to protect the apparatus against damage.

Indicates dangerous voltages.

Indicates a protected ground terminal.

Eye damage may result from directly viewing light produced by deuterium lamps 
used in detectors and spectrophotometers. Always turn off the deuterium lamp 
before opening the lamp door on the instrument.

!
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WARNING A warning alerts you to situations that could cause physical injury or damage to the 
equipment. Do not proceed beyond a warning until you have fully understood and 
met the indicated conditions.

CAUTION A caution alerts you to situations that could cause a possible loss of data. Do not 
proceed beyond a caution until you have fully understood and met the indicated 
conditions.
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Solvent Information

Observe the following recommendations on the use of solvents.

Flow Cells

Avoid the use of alkaline solutions (pH > 9.5) which can attack quartz and 
thus impair the optical properties of flow cells.

Solvents

Always filter solvents, small particles can permanently block capillaries. 
Avoid the use of the following steel- corrosive solvents:

• Solutions of alkali halides and their respective acids (for example, 
lithium iodide, potassium chloride, and so on).

• High concentrations of inorganic acids like nitric acid, sulfuric acid 
especially at higher temperatures (replace, if your analysis method 
allows, by phosphoric acid or phosphate buffer which are less corrosive 
against stainless steel).

• Halogenated solvents or mixtures which form radicals and/or acids, for 
example:

2CHCl3 + O2 → 2COCl2 + 2HCl

This reaction, in which stainless steel probably acts as a catalyst, 
occurs quickly with dried chloroform if the drying process removes the 
stabilizing alcohol.

• Analysis- grade ethers, which can contain peroxides (for example, THF, 
dioxane, di- isopropylether) such ethers should be filtered through dry 
aluminium oxide which adsorbs the peroxides.
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• Solutions of organic acids (acetic acid, formic acid, and so on) in 
organic solvents. For example, a 1- % solution of acetic acid in methanol 
will attack steel.

• Solutions containing strong complexing agents (for example, EDTA, 
ethylene diamine tetra- acetic acid).

• Mixtures of carbon tetrachloride with 2- propanol or THF.
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Lithium Batteries Information

WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the same or 
equivalent type recommended by the equipment manufacturer.

Do not dispose of lithium batteries in domestic waste.

Transportation of discharged lithium batteries through carriers regulated by 
IATA/ICAO, ADR, RID, IMDG is not allowed. Discharged lithium batteries must be 
disposed of locally according to national waste disposal regulations for batteries.
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For the latest information on products and services visit our worldwide 
web site on the Internet at:

http://www.agilent.com/chem
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Agilent 8453

controller area network (CAN), 136
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ambient temperatures, 21
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apertured cells or cuvettes, 41
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automated self-test, 35

B
baseline noise, 34
benzene, 45
blank, 38, 48
blank pushbutton, 25
bootp server, 126
bubble formation, 46
buffer handling, 134

C
cable

GPIB, 82

CAN
Agilent 8453, 136

CAN bus, 26
carbon disulfide, 45
carbon tetrachloride, 45
chloroform, 45
cleaning cells, 43
colloidal dispersions, 46
common solvents, 45
computer video socket, 29
configuration editor, 75, 136
configuration switch

8-bit configuration switch, 26
configuration switch module, 27
connecting power to your 

spectrophotometer, 27
connecting tubing, 53
consumption (line power), 19
contents of shipping container, 22
control switch module, 111
controller area network

Agilent 8453 Series, 136
cooling air, 20
cut-off filter, 47
cut-off wavelength, 47
cyclohexane, 45
cyclopentane, 45

D
default address, 27
degassed, 46
device configuration, 75
device configuration dialog, 137
dimethyl formamide, 45
dimethyl sulfoxide, 45
DIP switches, 112

dirty filters, 63
display, 29
dust, 46

E
electronic self tests, 32
entrapment of bubbles, 42
error condition, 24, 25
ethyl acetate, 45
ethyl ether, 45
excessive noise, 34

F
factory firmware settings, 113
fan, 32
flow cell, 42
flow cells, 50
frequency (line power), 19
front panel indicator, 24
front panel pushbuttons, 25
front view, 23
fuses, 19

G
general purpose input/output 

connector, 26
glass cells, 39
glycerol, 45
GPIB

cable, 82
GPIB address, 27
GPIB address definition, 111
GPIB cable, 27
GPIB connector, 26, 27
GPIB switch module, 26
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H
handling cells, 44
hardware

installing, 66
hardware address, 126, 129
highest precision measurements, 42
homogeneity, 48
host name, 134, 139
HPLC grade water, 46
humidity, 21

I
indicator, 32
indicator on front panel, 24
Installation of the TCP/IP protocol using 

Windows VISTA, 120
Installation of the TCP/IP protocol using 

Windows XP, 117
installing

hardware, 66
installing the waste tubing, 28
instrument icons, 34
instrument types in configuration 

editor, 127
isopropyl alcohol, 45

J
JetDirect card

Agilent 8453 IP addresses, 125

K
keyboard, 29

L
lamp intensity, 33
lamps start turning on, 32
LAN, 123

LAN adapter
JetDirect card, 123
TakkToLab card, 123

Lan Adapter, 123
lens tissues, 43
license registration number, 72
light beam, 40, 43
line frequency, 19
line power consumption, 19
line power input socket, 26
line power supply, 19
line power switch, 24
line voltage, 19
liquid samples, 38

M
MAC address, 126, 129, 134
magnetic impeller, 54
magnetic induction stirring, 54
making measurements, 38
methanol, 45
methyl formate, 45
MIO board slot, 26
mouse, 29
multicell connector, 26
m-xylene, 45

N
n-butyl alcohol, 45
n-hexane, 45
non-volatile memory, 112

O
offline mode, 34
online mode, 34
operating

conditions, 21
optical filter, 47
optical self tests, 32
optical specifications of cells, 40
optical surfaces, 43

P
parallelism, 40
particulate matter, 46
passivating new cells, 43
photochemical reactions, 47
photodegradation, 47
photographic lens tissues, 63
photosensitive substances, 47
pipette, 44
plastic sample cells, 39
poor linearity, 41
poor photometric accuracy, 41
power consumption, 19
power supply, 19
power switch, 24
printer cable, 29
proper operating condition, 34
pushbuttons, 25
pyridine, 45

Q
quartz sample cells, 39

R
rapid absorbance changes, 47
ready to measure, 32
recommended cells, 41
red blinking error condition, 25, 32
red error condition, 24, 32
relative humidity, 21
remote connector, 26
repeat ignition cycle, 32
RS 232 connector, 26

S
safety light switches, 26
sample, 38, 48
sample cell, 38, 46
sample degradation, 62
sample pushbutton, 25
screen element color, 76
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sensitivity, 41
setting up an additional 

spectrophotometer, 75
shipping container contents, 22
signal to noise ratio, 47
single beam instrument, 38
sipper system, 42
sipper/sampler system, 46
software certificate and registration 

packet, 73
solute convection, 46
solution, 48
solution noise, 46
solvent, 38
solvent suitability, 45
solvents, 45
spikes, 34
stabilize, 33
standard cells, 50
standard pushbutton, 25
standard single-cell cell holder, 50
stirring, 46
stirring module, 47
stop pushbutton, 25
stoppered sample cell, 46
stray light, 23
sulfuric acid, 45
supply (line power), 19
switches

power, 27

T
TalkToLab, 123
temperature control, 46
temperature fluctuations, 21
temperatures, 21
thermal equilibrium, 53
thermostattable cell holder, 47
thermostatted water, 53
thermostatted water bath, 52
toluene, 45

trimethylpentane
2,2,4-trimethylpentane, 45

turn on your spectrophotometer, 31
turn-on self-test, 34

U
useful wavelength range of solvents, 45
UV grade water, 46

V
video socket on computer, 29
viscous solutions, 47
volatile solvents, 46
voltage (line power), 19

W
waste container, 28
water, 45
wedge shaped cells, 40
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In This Book

This handbook describes the 
steps needed to install your 
new Agilent 8453 UV- visible 
spectroscopy system.

Most of the handbook deals 
with installing a complete 
system, that is, 
spectrophotometer, computer 
and printer. However, in the 
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and configuration, and 
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